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Let Us Start

EVOLUTION OF COMPUTERS 1

Hello, Friends! 
Remember me? I am 
Clicko. Today, we will 

learn about the history 
and development of 

computers.

A Computer is a machine used for calculation or computation. But modern day 
computers are much more evolved and advanced in technology than just that. 
From their inception to date, the computers have evolved from a machine that 
occupied an entire room to a device that can fit in the palm of your hand like your 
smartphones.

Let Us Do 1: Can you identify the given machines and name their inventors?

________________________	 _________________________

________________________	 _________________________
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We will learn how computers evolved from counting machines into the 
intelligent, digital machines they are today.

In this lesson

The first devices for counting like the Abacus and Napier’s Bones are manual 
calculators, and the earlier machines like the Analytical Engine developed by 
Charles Babbage were mechanical devices. The later machines used electricity 
and are considered as electronic machines. After the early mechanical machines, 
the development of the modern electronic computers took place in 5 different 
phases known as Generations of Computers.

Each generation saw changes in technology. This made the new computers 
smaller, cheaper, faster, more reliable and more powerful.

First Generation 
Features (Vacuum Tube Age) - [1940 to 1956]

• First age generation computers were built with vacuum tubes.

• These were huge in size.

• 	�They were very expensive, used
a great deal of electricity and
generated a lot of heat.

•  Input was based on punch cards
which was a very slow process.

• Output was in the form of printouts.

• 	�They were prone to frequent
hardware failure.

Some computers of this generation:

• EDVAC (Electronic Discrete Variable Automatic Computer)

• ENIAC (Electronic Numerical Integrator and Computer)

Figure 1.1: 1st Generation computers
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• UNIVAC (Universal Automatic Computer)(Figure 1.2)

• IBM 650

Second Generation
Features (The Transistor Age) - [1956 to 1963]

• 	�Computers became faster, smaller, cheaper and more
energy efficient.

• Transistors replaced vacuum tubes.

• 	�Input was still in the form of punched cards

• Output was in the form of printouts.

• 	�Programming was done in machine
language.

Some computers of this generation: 

• IBM 7000

• IBM 1401

• ATLAS

Third Generation
Features (The Integrated Circuit Age) - [1964 to 1970]

•  Supported high-level languages like COBOL, BASIC,
PASCAL etc.

• 	�The Integrated Circuit [IC] (Figure 1.5) replaced
Transistors.

• 	�Computers became smaller in size and
generated less heat.

• Maintenance cost was lower.

• These computers had keyboards and
monitors.

• 	�The Highly sophisticated technology was required for the manufacture of the
IC chips.

Figure 1.2: 2nd Generation computers

Figure 1.3: Integrated Circuit board
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Some computers of this generation:

• IBM 1130

• UNIVAC 1107

• Altair

Fourth Generation 
Features (The Microprocessor Age) - [1971 to 1979] 

• 	�Computers became much smaller. What earlier filled an entire
room could now fit into the palm of our hand.

• 	�The microprocessor was developed in the fourth generation of
computers.

• 	�Computers were much faster in computation than the previous
generations.

• They became much cheaper.

• Floppy disks and the mouse began to be used.

• High-level languages such as C, C++ began to be used.

Some computers of this generation:

• CRAY-1 (Super Computer)

• CRAY-X-MP (Super Computer)

• Altair

The first Microprocessor Intel 4004 consisted of 2250 transistors 
and was designed by Intel Corporation engineer Ted Hoff in 
1971. It was a 4-bit microprocessor.

Do You Know?

Fifth Generation 
Features (The Age of Connectivity) - [1989 to Till date] 

• They are artificially intelligence and may think and behave similarly to
humans.

Figure 1.4: 4th Generation 
computers
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• They are able to recognize images and graphs.

• They can use more than one CPU for faster
processing speed.

• They can process natural language.

• They may have knowledge based processing units.

Some computers of this generation:

• Desktop

• Laptop

• Notebook

• Ultrabook

• Chromebook

1. �Language – A formal set of rules for instructing a computer to perform
specific tasks.

2. Natural Language – A language that has evolved naturally in humans.

3. 	�Integrated Circuit: An integrated circuit (IC) is a small electronic device
made out of a semiconductor material. It is also called a chip or microchip.

4. 	�Artificial Intelligence – the capability of a computer to imitate intelligent
human behavior.

Glossary

  Teacher’s Notes
• 	�Discuss with the children the evolution of computers from desktop to the tablets

and smartphones they now use.

• 	�Ask children to make charts for each computer generation with pictures and
details about that generation.

Figure 1.5: 5th Generation computers
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Student’s Notes
• Make notes on the various I/O devices used by each computer generation.

• 	�Write short notes on the difference between computer evolution in the
mechanical era and the electronic era.

EXERCISE

1. Multiple Choice Questions

a) 	�The development of the modern electronic computers took place in 5
different phases known as:
A) Mechanical Era B) Era of computers

C) Generation of computers D) Features of Computers

b) The fifth generation computers will be able to recognize:
A) high-level languages B) punch cards

C) microprocessors D) images and text

c) 	�As compared to the previous generation of computers the next
generation was:
A) more expensive and larger

B) less energy efficient

C) faster and less reliable

D) smaller and faster

d) Which one is not true about the fifth generation computers?
A) They are cheaper B) They are compact

C) They are reliable D) They use transistors
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2. True or False
a) The second generation computers supported high level languages. ________

b) Cray 1 is a fourth generation computer. ________

c) IC chips replaced transistors in the second generation. _______

3. Fill in the blanks
a) 	�The fifth generation computers will have the ability to process ________________

language.

b) 	�The microprocessor was developed in the ______________ generation of
computers.

c) ____________ replaced the vacuum tubes.

4. Match the following

a) Desktop i) Memory and circuitry

b) IBM 1130 ii) Programming

c) Machine language iii) Fifth generation

d) Vacuum tubes used for iv) Third generation

5. Very Short Answer Questions
a) Floppy disk and mouse were first used in which generation of computers?

Ans.	 _________________________________________________________________________

b) What kind of processing units will the fifth-generation have?

Ans.	 _________________________________________________________________________

6. Short Answer Questions
a) Write two keywords for each of the five generations of computers:

1. First generation

Ans.	 _________________________________________________________________________
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2. Second generation

Ans.	 _________________________________________________________________________

3. Third generation

Ans.	 _________________________________________________________________________

4. Fourth generation

Ans.	 _________________________________________________________________________

5. Fifth generation

Ans.	 _________________________________________________________________________

b) Write the Full Form of the Following Abbreviations

1. EDVAC : _______________________________

2. ENIAC :  _______________________________

3. UNIVAC : _______________________________

7. Long Answer Question
Write a short note on the 4th generation of computers and give examples of the 
same.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question
Here is a picture which tells about the history of computers from the mid-twentieth 
century.
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Study the picture and answer the following questions.

a. 	�From the figure can you tell which was the technology used in the first,
second, third, fourth and fifth generation computers?

b. 	�Name two first generation computers.

c. 	�Which invention resulted in the evolution of the Second generation computer?

d. 	�Give some examples of fifth generation computers.

ACTIVITY
Students act out as computers of a different period of time. One student acts 
as humans called computers, one as the abacus and so on. This way cover, all 
the historical developments included in the lesson such as Napier bones, 
Pascaline, analytic engine, punched card up to the present day embedded 
computers in cell phones.

Now act out a skit where you share with the class details about when you were 
invented, who invented you and for what purpose you were used. After each 
character has acted out their part, the teacher can quiz the class on the details of 
the different machines that form the history of computers.
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DATA STORAGE MEDIA 2

Hello, friends. You must have lots 
of games, music, photos and 
movies saved on your computer. 
But do you wonder how the 
computer can store so many 
things? Let us know.

Let Us Start
We know the basic parts of any computer system are Monitor, CPU, Keyboard 

and Mouse.

Let us discuss the storage devices and memory units of a computer in this lesson.

Let Us Do 1: Identify the following parts.
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We will learn about the units of storage and storage devices.

In this lesson

Storage Units
A computer can only understand machine language or binary language. This 
language is called Low Level Language.

The Low Level Language uses the binary units of 0 and 1. The short form of binary 
digits is bits. Bits and Bytes are the most common units of storage in a computer.

We will learn more about these. Following are the main memory storage units.

1. Bit A bit is the short form of the binary digits 0 and 1. It is the 
smallest unit recognized by the computer. All sorts of 
information like words, audio, videos can be stored as 
patterns of these two digits 0 and 1.  The digits 0 and 1 are 
recorded as pulses of electricity on tiny electric circuits.

2. Nibble A group of 4 bits is called a nibble.

3. Byte A group of 8 bits is called a byte. A byte is the smallest unit 
which can represent a data item or a character.

4. Word A computer word, like a byte, is a group of fixed number 
of bits processed as a unit which varies from computer to 
computer but is fixed for each computer.
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There are higher units of storage as well.

Sl.No. Unit Description
1. Kilobyte (KB) 1 KB = 1024 Bytes

2. Megabyte (MB) 1 MB = 1024 KB

3. Gigabyte (GB) 1 GB = 1024 MB

4. Terabyte (TB) 1 TB = 1024 GB

5 Petabyte (PB) 1 PB = 1024 TB

It will take 5 Megabytes of data to store all the works of Shakespeare.

Fun Fact

Let Us Do 2:  Convert 1 MB into bytes.

_________________________________________________________________________

Let us now learn about the memory of a computer.

Memory of a Computer
Memory is just like a human brain. Computer memory is the storage space in computer 
where data is processed and instructions required for processing are stored.

Memory is divided into large number of small parts called cells. Each cell 
has a unique address varying from zero to memory size minus one.

Do You Know?

Types of Memory

We already know by now that the computer stores all the work done on it. All the 
information stored in the computer memory is made up of chips. There are two 
kinds of memory –
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• Primary Memory

• Secondary Memory

Primary Memory: The Primary memory or Internal Memory is the part of the computer 
which stores data temporarily during execution. It has limited capacity and data 
is lost when power is switched off. 

Characteristics of Primary Memory
• It is a semiconductor memory, known as main memory.

• It is usually volatile memory as the data is lost in case power is switched off.

• It is the working memory of the computer.

• A computer cannot run without primary memory.

RAM and ROM are two kinds of Primary Memory of a computer.

a) RAM (Random Access Memory) can store data and instructions
only when the computer is turned ON. We can read and write data
on the temporary memory. If the power suddenly goes off all the
data stored on it is lost. So, RAM is also known as Volatile Memory.

b) ROM (Read Only Memory) stores program and instructions
which are required to run the programs. Programs stored
on the ROM can only be read. ROM holds data permanently.
You cannot write on the ROM.

The information on ROM does not get wiped out when the computer is turned off.

Different types of ROM are:

■ 	�PROM (Programmable Read Only Memory): The information recorded on
PROM cannot be changed.

■ 	�EPROM (Erasable Programmable ROM): The stored memory in EPROM can
be erased by exposing it to the ultraviolet light.

■ 	�EEPROM (Electrically Erasable Programmable ROM): The information written
on EEPROM can be erased by using electric signals.
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Secondary Memory: This type of memory is also known as external memory or non-
volatile memory. These are used for storing data/Information permanently. CPU 
directly does not access these memories instead they are accessed via input-
output routines. Contents of secondary memories are first transferred to main 
memory, and then CPU can access it. For example: disk, CD-ROM, DVD etc.

Characteristic of Secondary Memory:

• It is a magnetic and optical memory, also known as backup memory.

• 	�It is non-volatile memory, as the data is permanently stored even if power is
switched off.

• It is used for storage of data in a computer.

• Computer may run without secondary memory.

• Slower than primary memories.

Below are the some examples of Secondary memory:

a) CD means Compact Disk.  It can store and read data and programs.

b) �DVD means Digital Versatile Disk. It is flat and round. It looks very
similar to CDs. It can store more data than a CD.

c) �Hard Disk can contain much more data than either a CD or
DVD. The hard disk is placed inside the CPU box.

d) �Pen Drive is a pen-like device.  It is attached outside the
computer. A pen drive can also store large amount of data.
Pen drive is the most convenient device to carry data from one
place to another as we can put it in our pocket.
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Let Us Do 3:  Write the full forms of:

CD

DVD

RAM

ROM

PROM

EPROM

EEPROM

Cache Memory

A Cache (pronounced as “cash”) is located inside or close to the CPU chip. It is 
a small and very fast temporary storage memory. It is designed to speed up the 
transfer of data and instructions. It is faster than RAM and the data/instructions that 
are most recently or most frequently used by CPU are stored in cache.

The data and instructions are retrieved from RAM when CPU uses them for the first 
time. A copy of that data or instructions is stored in cache. The next time the CPU 
needs that data or instructions, it first looks in cache. If the required data is found 
there, it is retrieved from cache memory instead of main memory. It speeds up the 
working of CPU.
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1.  Volatile memory: is computer storage that only maintains its data while the
device is powered.

2.  Semiconductor: a solid substance that has conductivity between that of an
insulator and most metals.

3. Erase: to delete or remove the contents.

4.  Backup: refers to the copying of computer data so it may be used to restore
the original after a data loss event.

6. Binary: Binary numbers are made up of binary digits (bits).

7.  Magnetic disc: A memory device, such as a hard disk, that is covered with
a magnetic coating.

8.  Optical: A storage medium from which data is read and to which it is written
by lasers.

Glossary

  Teacher’s Notes
• 	�Tell the students the different memory units and the conversion from one to

another.

• Show and explain the different types of computer memory to the students.

Student’s Notes
• Translate all the higher memory units into bytes.

• Prepare a chart of memory devices and stick it in your classroom.

EXERCISE

1. Multiple Choice Questions

a) The computer understands the following language:
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A) Low Level Language B) High Level Language

C) Middle level language D) C Language

b) Which of the following is NOT a type of ROM?
A) PROM B) APROM

C) EEPROM D) EPROM

c) Which of the following is the fastest memory?
A) Cache B) RAM

C) ROM D) Pen drive

2. True or False
a) 	�A byte is the smallest unit which can represent a data item or a character.

__________

b) 1 byte = 8 nibbles. ____________

c) Computer memory is divided into cells. ___________

3. Fill in the blanks
a) ___________________ is the most convenient device to carry data from one

place to another.

b) The Low Level Language uses the binary units of ________and ______________.

c) A ___________________ memory is located inside or close to the CPU chip.

4. Match the following
	  i) 1024 KB

b) 1 Megabyte (MB) ii) 1024 Bytes

c) 1 Gigabyte (GB) iii) 1024 GB

d) 1 Terabyte (TB) iv)1024 MB
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5. Very Short Answer Questions
a) Arrange the following in order of its size:

Bit, kilobyte, nibble, gigabyte, byte

Ans.	 _________________________________________________________________________
b) Arrange the following in order of its data holding capacity:

Hard disk, CD, DVD

Ans.	 _________________________________________________________________________

6. Short Answer Questions
a) Give two differences between primary memory and secondary memory?

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

b) How is RAM different from ROM?

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

7. Long Answer Question
Write the characteristics of three different types of ROM.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture based Question
Identify the following devices:

ACTIVITY
Complete the flowchart
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Let Us Start

TOUR TO WINDOWS3

Hello, Friends! we learned to 
give a new look and feel 

to our computer according 
to our intrest. Let’s now 

know how we can organize 
our system withs files and folder

Let Us Do 1: Identify the following as secondary or primary memory.

_________________ _________________ _________________
In the previous lesson, we learnt about the various types of storage devices. We 
also learnt what primary memory and a secondary memory are in our computers.

Now we need to learn how to save our work and save and keep track of where all 

that saved work is Understanding how to work with files and folders is an important

part of managing the information on our computer. As we accumulate more files

more files on our computer, we need to create new folders to help keep things 
organised. 
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We will learn 

• More about Windows Explorer

• To manage files and folders in our computer

In this lesson

Windows Explorer
 In the previous classes, we have learnt about Windows environment and the 
Windows desktop.

Windows has a GUI (Graphical User Interface). This means we can give most 
commands by moving the mouse and clicking on icons, buttons and menus. We 
shall now learn about an important feature of Windows Explorer.

Windows Explorer displays the ordered structure of files, folders, and drives on our 
computer. Using Windows Explorer, we can copy, move, rename, and search for 
files and folders. 

It is a file manager program that allows us to browse through the contents of the 
hard drive. With Windows Explorer, we can browse through our pictures, music, 
documents and videos from one location. 

Windows Explorer can be opened using a number of methods:

Method 1: Click Start → All Programs → 
Accessories → Windows Explorer

Method 2: Click Start → Run → explorer.
exe 

Method 3: Hold the Windows Button on 
the keyboard and press ‘E’ 

Method 4: Right-click the “Start” menu 
and click “Open Windows Explorer.” 
Windows Explorer opens for us to 
browse the hard drive content. Figure 3.1
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Method 5: Click the “Start” menu and type “explorer” in the instant search box. 
Windows Explorer appears in the list for you to click. 

Windows explorer replaced File Manager in versions of Windows 
prior to Windows 95.

Do You Know?

Managing Files and Folders
When we work regularly on the computer, we start creating a number of files 
which may contain important data and information regarding various aspects 
of our professional and personal activities. There could be letters, presentations, 
photographs, videos and many other things. 

A file can represent anything we create or load 
onto our computer. Just as with any filing system, 
it is important to store our files systematically so 
that they can be retrieved easily when required.

Creating a folder

We can sort and keep important files in different 
folders.

To create a folder:

STEP 1: �Go to the location (such as a folder or the desktop) where the new folder 
is to be placed.

STEP 2: �Right click on an empty area. The File menu 
appears (Figure 3.2).

STEP 3: Select ‘New’. 

STEP 4: �Select ‘Folder’. Type a name for the new folder, 
and then press Enter.

The new folder will appear on the desktop. You can 
rename the folder as you like. Here, the folder has been 
named Homework by typing.

Figure 3.2
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Creating a new file

There are many ways to create a file on your computer. Since Windows 95, 
Microsoft Windows has offered a way to create a blank file, without having to 
open any separate application, by using the context menu of Windows 
Explorer.

Say, you want to create a new file in Notepad. Notepad is a text editor 
like WordPad. 

STEP 1:  Double click on the ‘Homework’ folder you have just created. 

STEP 2:  Right Click on an empty area. A menu appears. 

STEP 3: Move to ‘New’.

STEP 4: Click on ‘Text Document’. (Figure 3.3) 

A window with a new notepad file New Text 
Document.txt shows up. The.txt extension will be 
added automatically by Windows since this is a 
Notepad file.
STEP 5: Give the document a name, say Science.

STEP 6: A Notepad file Science.txt has been 
created (Figure 3.4). 

STEP 7: Double click the file to open it and type in some text. 

Saving a file

• When you have finished typing, click on File menu.

• Click on the Save option. The file is saved.

Figure 3.3

Figure 3.4
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Renaming a file

A file can be renamed by using the Rename option. 

STEP 1:    Right click the file you want to rename. A 
shortcut menu appears

STEP 2: Click on the Rename option (Figure 3.5). 

STEP 3: The file name gets highlighted.

STEP 4: Type the new name, and then press Enter.

STEP 5: The file has been renamed.

Copying a file or folder

A file or folder can be copied from one location to another location by using Copy 

and Paste options.

STEP 1:  Right click the file (or folder) you want to 
copy. A shortcut menu appears. 

STEP 2: Click on Copy (Figure 3.6).

STEP 3:  Now go to the location you want the file 
to be copied, say desktop. 

STEP 4: �Right click the mouse button on the 
desktop. 

STEP 5: Click Paste (Figure 3.8) on the shortcut 

menu.

A copy of the file is transferred to the new 

location. The original file can still be found in the 

old location. 

Moving a file or folder
You can move a file from one location to 

another by using the Cut and Paste options. 

STEP 1: Right click the file you want to move. 

STEP 2: A shortcut menu appears.

Figure 3.5

Figure 3.6

Figure 3.7
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STEP 3:  Click on the Cut option. (Figure 3.7) The file disappears. It is now temporarily 
stored in a location called Clipboard. 

STEP 4: �Now go to the location you want the file to be 
moved to.

STEP 5: �Right click the mouse button. A shortcut menu 
appears. 

STEP 6:  Click Paste (Figure 3.8).

The file has been moved to the new location. Unlike 
the Copy-Paste option, the file no longer exists in the 
old location.

Accessories
Let us read about few Windows accessories which 
are used by us frequently.

Calculator
The Calculator can be opened also by typing calculator or calc in the Start Menu 
search box in Windows 7 (Figure 3.9). 
The Calculator has 4 main modes with which you can do calculations:

• The Standard Mode.

• The Scientific Mode.

• The Programming
Mode.

• The Statistics Mode.

Notepad
Notepad is a very basic text editor that’s been part of Windows for a very long 
time. It is used for writing relatively short documents that you want to save as 
plain text. In Windows 7, Notepad is found in the Accessories folder in the Start 
Menu(Figure 3.10).

Figure 3.8

Figure 3.9
Calculator
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Run
This command allows us to execute 
any programs which are otherwise not 
available in the form of an icon or a 
menu.

WordPad
WordPad can be used to create 
simple text documents that can be 
saved and printed.

Figure 3.10

Notepad window

Run Command

Wordpad window
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WordPad was first introduced on the Windows 95 operating system.

Do You Know?

1. 	�GUI: Graphical User Interface allows users to interact with electronic devices
through graphical icons etc. instead of text based user interface.

2. 	�File manager: A program used to organize, list and locate files on computer.

3. 	�Clipboard: A clipboard is a temporary storage area for data that the user
wants to copy from one place to another.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Briefly, explain to the students about the windows explorer.

• Show the different locations where we store files and folders in our computer.

Student’s Notes
• Find out the different ways to create files and save them in My computer folder.

• 	�Open My Documents on your desktop and make different folders there and
then rename them.
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EXERCISE

1. Multiple Choice Questions
a) Windows has a

A) Designer user interface B) Graphical user interface

C) Programming user interface D) Basic user interface

b) File manager program allows you to

A) Browse content of hard drive B) Rename files

C) Delete files D) Copy files

c) WordPad is used to

A) Execute programs B) Create simple text

C) Do calculations D) Edit images

2. True or False

a) Windows 7 Calculator has four modes. ____________

b) To move a file from its location, click on rename.	 __________

c) It is important to name a newly created file. _________

3. Fill in the blanks

a) WordPad was first introduced on the ____________ operating system.

b) Notepad is a very basic _________________.

c) 	�Windows explorer displays a ____________________ structure of files and folders
on your computer.
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4. Match the Following
a) �To move a file from one location

to other
i) Accessories folder

b) �Notepad is found in ii) Select cut paste option

c) �Mode of calculator iii) Clipboard

d) �Files we move are temporarily
stored in

iv) Scientific mode

5. Very Short Answer Questions

a) Name any two windows accessories.

Ans.	 1) __________________ 2) _______________________

b) Write the steps to save a file.

Ans.	 _________________________________________________________________________

6. Short Answer Questions

a) Define the function of file manager program.

Ans.	 _________________________________________________________________________

b) Why is it necessary to manage your files and folders?

Ans.	 _________________________________________________________________________

7. Long Answer Question

Write the steps to create a new folder.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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8. Picture Based Question

Write the uses of these Windows accessories.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

Activity
Try out various other accessories present in windows 7. Open Windows calculator 
and try the different modes.
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Let Us Start

STYLES AND OBJECTS 4

Hey Friends, let’s learn how 
we can add images and 

different styles to our Word 
document.

In the earlier classes, we have learnt about how to edit text in MS Word. You also 
learnt to use different formatting features.

Let Us Do 1: Open MS Word and write the below text in different formats.

HELLO FRIENDS, WE ARE LEARNING MS WORD.

HELLO FRIENDS, WE ARE LEARNING MS WORD.

HELLO FRIENDS, WE ARE LEARNING MS WORD.

HELLO FRIENDS, WE ARE LEARNING MS WORD.

We will learn 

Different shapes and symbols available in MS Word. We will also learn how to 
work with different objects in a document.

In this lesson
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While using a word processor it may be necessary to insert special characters 
into your documents. These characters may include an ellipsis, accented letters, 
foreign language characters, copyright, math symbols, uncommon punctuation, 
trade symbols, different world currency symbols, etc. Due to limited space for keys 
and because many of these symbols are uncommon, you won’t find most of them 
on a standard keyboard. However, all programs and services allow the ability to 
insert these.

Shapes and Symbols
Draw a Shape

MS Word comes with a variety of shapes, lines, 
arrows and more that can be drawn in your 
document.

STEP 1: Go to Insert tab and click on Shapes 
(Figure 4.1).

STEP 2: Select the shape that you want.

STEP 3: Move your mouse where you want to 
draw the object and while holding down the 
mouse button, draw the shape. 

The pointer will look like a plus (+) while drawing 
shapes.

Inserting Symbols

Often in documents, we need to insert special characters 
not found on the keyboard, like paragraph symbols (¶) or 
section symbols (§).  Here’s how to do that:

STEP 1: Click where you want to insert the symbol.

STEP 2: On the Insert tab, in the Symbols group, click Symbol. 
(Figure. 4.3)

STEP 3: Do one of the following:

Figure 4.1

Figure 4.2

Figure 4.3
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• Click the symbol that you want in the drop-down list.

•  If the symbol that you want to insert is not in the list, click More Symbols.
In the Font box, click the font that you want, click the symbol that you
want to insert, and then click Insert (Figure 4.4).

Figure 4.4

STEP 4: Click Close.

“Formatting for the symbols, such as size and color, is same as text.”

Do You Know?

Borders and Shading
To improve the appearance of the text and make it more attractive we can apply 

a variety of borders and shading effects to the text and entire page. 

A border is a line added above, below, to the side of, or around words or paragraphs. 

Shading is the color or pattern that is added behind words or paragraphs.

To add a page or paragraph border, 
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STEP 1: Select the text. 
Click on Page Layout tab 
and select Page Borders  
(Figure 4.5).

STEP 2: Click on the Borders/ 
Page Border tab to select 
a border (including style, 
color and width). (Figure 
4.6)

Figure 4.6

STEP 3: Select the appropriate option, Text or paragraph, from the Apply To list box.

STEP 4: Click OK to apply a border to the selected text.

To apply shading, follow the steps given below.

STEP 1: Select a text or a paragraph.

STEP 2: Click on the Shading tab under Page Layout Tab (Figure 4.7). 

STEP 3: Click to select the shading fill color you want to apply to the text or paragraph.

STEP 4: Apply any other options you want. Click OK.

Figure 4.5
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Figure 4.7

We can also apply borders and 
shading to the text using the Border 
and Shading options available under 
Home tab-Paragraph group.

Using Drop Cap
A drop cap is a specially formatted letter that appears at the beginning of a 
paragraph. There are two styles of drop cap. The first begins the paragraph with 
a large letter that spills down into the text. The second style places the large first 
letter in the margin adjacent to the paragraph.

STEP 1: Select the letter you want to insert as a Drop Cap.

My name is Clicko and it rings with Rico. I am here to help 
you. Let us work on this together.

Place your 
cursor here.
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STEP 2: Go to Insert tab and click on Drop Cap 
button (Figure 4.8).

STEP 3: Click it, and hold the mouse pointer over 
your choice to see a preview in your document.

My name is Clicko and it rings with Rico. 
I am here to help you. Let us work on 
this together.

Letter “M” updated.

Word Art
WordArt is a text modifying feature in Microsoft Word, a popular word processing 
program. It includes effects such as shadows, outlines, colors, gradients, and 3D 
effects that can be added to a word or phrase. WordArt can also bend, stretch, 
skew, or otherwise modify the shape of the text.

You can use WordArt to make display text (e.g., the heading of your document) 
more eye-catching. WordArt can be resized, moved, and edited to fit your needs.

STEP 1: Click on the Insert tab and select the 
Word Art option under Text group. 
(Figure 4.9)

STEP 2: A list of various designs is shown. 
(Figure. 4.10)

Figure 4.10

Figure 4.8

Figure 4.9
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STEP 3: Choose the item in the Word Art list and the following dialog box appears. 
(Figure 4.11)

Figure 4.11

STEP 4: Enter your text in the Text Area and click OK

Let Us Do 2: Create a word doc and add different shapes to it. 

Also, add text and use the drop cap option.

1. 	�Symbols: option to add those symbols which are not part of a regular
keyboard.

2. 	�Drop Cap: specially formatted letter that appears at the beginning of a
paragraph.

3. Word Art: Tool used to make display text more eye catching.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Show the students different shapes that can be drawn in a document.

• Show them how to change the colors of a shape.

• 	�Demonstrate to students how text can be made more attractive by using
Borders and Shading feature
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Student’s Notes
• Open MS Word and create a document with a page border.

• Save this document with the file name “My First Art”.

• 	�Give a proper heading using WordArt. You can also use WordArt in different
styles at suitable places in the document.

EXERCISE

1. Multiple Choice Questions
a) The following option allows you to add special symbols to the document:

A) Page B) Borders C) Symbol D) Insert

b) How many styles are there under the Drop Cap option?

A) Three B) One C) Five D) Two

c) To add borders, you have to choose the following tab:

A) Page Layout B) Home

C) Insert D) View

2. True or False

a) Drop Cap option works on entire paragraph. __________

b) You cannot change the size and color of symbols. __________

c) Word Art makes the text more pretty. ___________

3. Fill in the blanks

a)  Some symbols that are not available on keyboard but can be added through
Symbols option are ___________, ___________ and ____________.

b) A circle can be added by choosing it from __________ option.

c) There are ______________ styles of drop cap.
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4. Match the Following
a) Shapes

i)   
b) Word Art

ii)  
c) Apply page Borders

iii) 
d) Insert symbol

iv) 

5. Very Short Answer Questions
a) Name two effects that can be added to Word Art.

Ans.	 _________________________________________________________________________

b) Name this effect.

Ans.	 _________________________________________________________________________
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6. Short Answer Questions

a) Why do we use Word Art?

Ans.	 _________________________________________________________________________

b) Explain Drop Cap and what are its 2 different styles?

Ans.	 _________________________________________________________________________

7. Long Answer Question

Explain the steps to add a border to a paragraph.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question

Look at the picture below. What option is highlighted? Write down the steps for 
adding this to your word document.

Ans. __________________________________________________________________________

  ________________________________________________________________________ 

Activity
Try to make the following word art option in MS WORD.

            _________________________________________________________________________

            _________________________________________________________________________
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Let Us Start

WORKING IN A TABLE5

Hey Friends, today we will learn 
about how to work in a table in 

MS Word.

In earlier classes, you have learnt about how to work on MS Word and use its 
different features.

Let Us Do 1: Write the total number of students in each section of class 5 in a  
tabular form

We will learn 

• How to create a table in MS Word

• How to add, delete or edit the table

In this lesson
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Tables are used in documents to organize and present information in an effective 
format. A table is made up of horizontal rows and vertical columns. It is a grid of 
cells arranged in rows and columns. Tables are useful for various tasks such 
as presenting text, information and numerical data. In Word, you can create a 
blank table, convert text to a table, and apply a variety of styles and formats 
to the existing tables.

Create a Table
You can create Tables in three different ways:

Method 1:
STEP 1: �Click on the place where you want to create 

a table.

STEP 2: Click INSERT on the Menu bar.

STEP 3: Click the drop down option of Table.

STEP 4: Click Table.

STEP 5: �the number of Rows and Columns by 
dragging the mouse over the cells.

Method 2:
STEP 1: Click on the place where you want to create a table.

STEP 2: Click INSERT on the Menu bar.

STEP 3: Click the drop down option of 
Table.

STEP 4: Click Insert Table.

STEP 5: �Select the number of Rows and 
Columns by using the mouse or 
keyboard to input the details as 
per your requirement. 

STEP 6: Click Ok.

Figure 5.1: Method 1

Figure 5.2: Method 2
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Method 3:

STEP 1: Click on the place where you want to create a table.

STEP 2: Click INSERT on the Menu bar.

STEP 3: Click the drop down option of Table.

STEP 4: Click Draw Table. The pointer will change its shape to a pencil.

STEP 5:  Draw a rectangle by dragging through left click in order to define the 
boundary of the Table.

STEP 6: Draw the Rows and the Columns.

STEP 7: �After drawing the Table, you can click a cell and start typing or insert a 
graphic.

Figures 5.3: Method 3

Insert Row and Column
So, now we know how to create a table. Now we will learn how to add rows 
or columns to an already existing table.
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Method 1:
Press Tab from the bottom-right cell in the table. This adds a new row and moves 
the insertion point to the first cell in the new row.

Figure 5.4: Method 1 to Add row

Method 2:
STEP 1: �Click anywhere inside a row above or below where you want to insert the 

new row.

STEP 2: �On the contextual Layout tab, click Insert Above or Insert Below, accordingly, 
in the Rows & Columns group.

Figure 5.5: Method 2 to Insert Rows/Columns

Method 3:
Right-click in the Table and choose Insert, and then select the appropriate 
insert command, whether you want to insert Rows or Columns.

Figure 5.6: Method 3 to Insert Rows/Columns
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Editing in a Table
After drawing tables if you want to erase it, click on the Eraser tool and drag it on 
the lines of the Table.

Figure 5.7: Erasing Table

How to delete a Table or its contents:

STEP 1: Click and select the Table.

STEP 2: Click and select the Table in the Menu bar.

STEP 3: Click the drop down option under the Delete option.

STEP 4: Click the Delete Table option. The entire Table and its content get deleted.

Figure 5.8: Deleting Table

Display or Hide Grid lines:

STEP 1: Click on the Design Menu bar.

STEP 2: �Click on the Borders drop-down menu. The drop-down 
menu appears.

STEP 3:  Choose ‘No Border’ to hide the grid lines. The grid lines 
will disappear.

Positioning the Table anywhere on a page:

STEP 1: �Keep the pointer on the table and move the mouse 
until a four-headed arrow appears. 

Figure 5.9: Borders



46

STEP 2: �Drag the Table by clicking the left mouse button to the required location 
in the page and then release the mouse button. The Table will shift to the 
required location.

Let Us Do 2: Using the ‘Insert’ tool create a table with the following columns:

Roll No., First Name, Last Name, Marks

Add information of 5 students.

1. Editing: Feature that allows us to make changes to the document.

2. Insert: Adds rows or columns to an already existing table.

3. Eraser: Tool used to remove the table lines.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Show students an example of how to create a table on the school computer.

• Allow students to add rows and columns to this table.

Student’s Notes
• 	�Open MS Word and create a table to show the below ingredients in two

columns:

½ cup Butter

2 ½ cups All Purpose Unbleached Flour

¾ cup White Sugar

¾ cup Brown Sugar

2 Eggs
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1 tsp. Vanilla

½ tsp. Baking Soda

¾ bag of Chocolate Chips

EXERCISE

1. Multiple Choice Questions

a) The following option allows hide/display the grid lines of table:
A) Page B) Borders

C) Layout D) None of the above

b) The following option allows you to delete the table:
A) Delete B) Distribute

C) Merge D) Insert

c) When you Click Draw Table option, the pointer will change its shape to:
A) Pen B) Pencil

C) Eraser D) None of the above

2. True or False
a) You can only create 1 table in a single word document. __________

b) You can hide the borders of a table. __________

c) You can add new columns to an existing table. ___________

3. Fill in the blanks

a) A table is made of _____________ rows and _______ columns.

b) We use __________ tool on the lines of the Table to erase a cell.

c) We choose _____________________ to hide grid lines.
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4. Match the Following

a) Table i) 

b) Columns
ii) 

c) Eraser iii) 

d) Row iv) 

5. Very Short Answer Questions

a) Can we create a blank table in word?
Ans.	 _________________________________________________________________________

b) Can we add more number of rows and columns in an existing table in word?

Ans.	 _________________________________________________________________________

6. Short Answer Questions

a) What is the use of a Table in Word?
Ans.	 _________________________________________________________________________

_________________________________________________________________________
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b) Explain the steps to hide the grid lines of a table.
Ans.	 _________________________________________________________________________

_________________________________________________________________________

7. Long Answer Question

a) Explain any two methods by which you can create a table.
Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question

Look at the picture below and explain this method of deleting rows/columns.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________



50

ACTIVITY
Find the following words in the below table:

DELETE INSERT COLUMN TABLE ROW WORD PAGE

P Q C E R T Y

A W O R D S U

G T L Q C B J

E G U A W N M

W H M T D M L

S I N S E R T

C J Y U L O A

V N T H E W B

F M R N T F L

R D F I E V E
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Let Us Start

STARTING WITH MS POWERPOINT6

Hello Friends, today we 
will learn something 

interesting about Microsoft 
PowerPoint. Let’s get 

started.

Let Us Do 1:

In the space given below, draw any object using the shapes used in Microsoft 
Word (Few shapes are given in the box for your reference).
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We have learnt Microsoft Word (often called Word) is a graphical word processing 
program that users can type with. It was developed by the company Microsoft. 
The purpose of MS Word is to allow the users to type and save documents. Similar 
to other word processors, it has many helpful tools to make documents.

We will learn 

• About MS PowerPoint

• How to create slides to make PowerPoint presentations

In this lesson

PowerPoint is a presentation software package. With PowerPoint, we can easily 
create slideshows. Trainers and other presenters use slide shows to illustrate their 
presentations.

Getting Started
This lesson introduces to the PowerPoint window. 
We use the window to interact with the software. 
To begin, open PowerPoint 2007 program. Click:

 �→ All Programs → Microsoft Office → 
Microsoft Office PowerPoint 2007

(Figure 6.1)

The original name of PowerPoint was 
“Presentation”. It was developed in 1984, 
and renamed to PowerPoint in 1987.

Do You Know?

The window appears and the screen looks similar to the one given below (Figure 6.2).

Figure 6.1
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PowerPoint Screen
When the PowerPoint program starts, a new presentation is created, and a blank 
slide appears in the window (Figure 6.2). The slide has a place to add a title and 
subtitle.

Figure 6.2

We access the various PowerPoint commands from the Ribbon. Above the Ribbon 
in the upper-left corner is the Microsoft Office button. From here, you can access 
important options such as New, Save, Save As, and Print.

On the left side of the window, you will see a task pane with slides and outline 
tabs, which appear by default. On the bottom-right of the screen, you’ll find view 
commands (Normal, Slide Sorter and Slide Show), as well as the zoom tool.

The Slide window is broken up into several areas:

• The Slide Pane: The Slide Pane appears in the center of the window.

• The Notes Section: The Notes Section appears at the bottom.
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There are also Placeholders (Figure 6.3) on each slide depending on the slide 
layout. These layouts may include placeholders for a slide title, subtitle, text, images, 
video, charts, graphs, etc. 

The placeholders hold the objects on 
your slides. 

We create our presentation by adding 
content to the slides.

To zoom in and out:

•	� Locate the zoom bar in the
bottom-right corner.

•	� Click the slider and drag it to the right to zoom in
and to the left to zoom out.

To change views

PowerPoint provides several views for you to 
work with. Each view is useful for a different set 
of activities. Normal view (refer to this figure), the 
default, is the most commonly used view. You can 
switch to one of the other views in either of these ways:

STEP 1: Locate the View options in the bottom-right corner. The view options are 
Normal, Slide Sorter, and Slide Show.

STEP 2: Click an option to select it.

The default is Normal view.

The Quick Access toolbar 

Next to the Microsoft Office button is the Quick 
Access toolbar.  If you wish to add other commands 
to make using PowerPoint features more convenient 
for you:

STEP 1: Click the arrow to the right of the Quick 
Access toolbar.

Figure 6.3

Figure 6.4

Figure 6.5
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STEP 2: Select the command you want to add from the drop-down list. It will appear 
in the Quick Access toolbar.

The Ribbon: The Ribbon is located near the top of the PowerPoint window, below 
the Quick Access toolbar.

Creating a New Presentation 
When we open PowerPoint from the Start menu or from an icon on your desktop, 
a new presentation with one slide appears by default. You can also create a new 
presentation while PowerPoint is already open.

Steps to create a new Presentation

STEP 1: Click the Microsoft Office button, and choose New 
from the menu (Figure 6.6). The New Presentation dialog 
box will appear.

STEP 2: Blank presentation is selected by default (Figure 6.7).

The fastest and simplest way to create a new presentation is to start with a blank 
one. You can then add text to the presentation, including additional slides.

Figure 6.7

Figure 6.6
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1. Graphical: related to use of diagrams, graphs, etc.

2. �Presentation: is the collection of individual slides that contain graphical
information on any topic.

3. �Ribbon: is the long strip containing tabs with buttons across the top of the
main window within the PowerPoint.

4. Slide: is a single page of a presentation.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Explain to the students how PowerPoint is used in various fields by professionals.

• 	�Open a PowerPoint screen and show the various components which help us to
create a new presentation.

• Show the students how to open a new PowerPoint presentation.

Student’s Notes
• 	�Click to open a new presentation. Try various options like Zoom in, zoom out

and change the view of the slides you create.

• Create your first presentation.
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EXERCISE

1. Multiple Choice Questions
a) To open Microsoft PowerPoint on your computer, we need to click on

A) All Programs B) Recent documents

C) Google chrome D) Microsoft Word

b) To change view of the presentation, we need to select

A) Normal view B) Slide show

C) Zoom in D) Slide sorter

c) To open a new slide, we can use this keyboard shortcut.

A) Ctrl+L B) Ctrl+S

C) Ctrl+N D) Ctrl+P

2. True or False

a) �We can create a new presentation while PowerPoint is already open.
_______________

b) �On the PowerPoint screen, above the Ribbon in the upper-left corner is the
Microsoft Office button. ________________

c) �Original name of PowerPoint was Presentation. _____________

3. Fill in the blanks

a)  �In PowerPoint 2007, we use the ____________________ option to issue
commands.

b) �We can access the various PowerPoint commands from the ______________
____________________ menu system.

c) �PowerPoint is a _________________ software package.
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4. Match the Following
a) PowerPoint logo

 i) 

b) View commands

ii) 

c) Zoom in and out

iii) 
d) Blank slide

iv) 

5. Very Short Answer Questions

Identify the option:

a) �We use this to add other commands to make using specific PowerPoint
features more convenient to use.

Ans.	 _________________________________________________________________________

b) We use this option to issue commands.

Ans.	 _________________________________________________________________________

6. Short Answer Questions

a) Where do you find these options on a PowerPoint window?

i) Task pane

ii) Zoom bar

Ans.	 _________________________________________________________________________

b) Write any one use of PowerPoint.

Ans.	 _________________________________________________________________________
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7. Long Answer Question

Write the steps to customize Quick access toolbar to add other commands as per 
our choice.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question

Write the steps to create a new presentation by referring to the images given 
below.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

Activity
Create a new PowerPoint presentation based on the activities you do during 
your weekend.  
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Let Us Start

MS POWERPOINT BASICS7

Hello friends, hope you all know 
what is PowerPoint. Get ready to 
learn something interesting about 
PowerPoint now.

Rearrange the jumbled words based on the previous lesson.

1. P O E N R P W I O T

______________________________________________

2. R P E T E N S A T O I N

_______________________________________________

3. I S L S E D

_____________________________

In the previous lesson, we learnt how to open MS PowerPoint and the steps to 
create PowerPoint presentation. We also learnt that PowerPoint is a presentation 
software package used to create slide shows.
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We will learn 

• To create slides for any PowerPoint Presentation

• To animate text and objects in PowerPoint

In this lesson

Features
PowerPoint includes all of the features you need to create any presentation. Some 
of the features are given below:

• Adding smart art

• Inserting shapes

• Inserting an image

• Slide transitions

• Adding animations

Slide Basics

Fun Fact

PowerPoint was originally developed just for the Apple Macintosh.

Slides appear in the center of the window. When you create a PowerPoint 
presentation, it is made up of a series of slides. The slides contain the information 
you want to communicate with your audience. This information can include text, 
pictures, charts, videos, sounds, and so on. 

Before we begin adding information to slides, we need to know the basics of 
working with slides. 

In this lesson, we will learn slides basics and how to insert new slides in our presentation.
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To insert text into a placeholder

STEP 1: �Click inside the placeholder. The 
placeholder text will disappear, 
and the cursor point will appear.

STEP 2: �Type your text once the cursor 
point is visible.

STEP 3: �Click outside the placeholder when 
you have entered all of your text 
into the placeholder.

Slide layouts

The placeholders are arranged in different 
layouts. We can select one when we insert 
a new slide or that can be applied to existing slides. In the figure shown above 
(Figure 7.1), the layout is called Title and Content and includes title and content 
placeholders.

A slide layout arranges your slide content.
Do You Know?

To insert a new slide

STEP 1: Click the New Slide command in the 
Slides group on the Home tab.

STEP 2: �A menu will appear with your slide 
layout options.

STEP 3: �Click the slide you want to insert. A 
new slide with the chosen layout 
will appear in the center of the 
PowerPoint window and in the pane 
on the left.

Figure 7.1 Sample Slide with Placeholders

Figure 7.2 To create a new slide
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To Delete a Slide 
STEP 1: Select the slide you want to delete. 

STEP 2: Click the Delete command in the Slides 
group on the Home tab (Figure 7.3).

STEP 3: �You can also delete a slide by pressing the 
Delete key on your keyboard.	

Animating Text and Objects

To apply a default animation effect
STEP 1: Select the text or object on the slide you want to 
animate.

STEP 2: Select the Animations tab.

STEP 3: �Click the Animate drop-down menu in the Animations 
group to see the animation options for the selection. 
The options change based on the selected item.

STEP 4: �Move your cursor over each option to see a live 
preview of the animation on the slide.

Click an option to select it.

To apply a different animation effect: 
STEP 1: Select the text or object on the slide you want to modify.

STEP 2: Select the Animations tab.

STEP 3:� Click Custom Animation in the 
Animations group. The Custom 
Animation task pane will appear on 
the right.

STEP 4:� Select the animation in the Custom 
Animation task pane, if it is not 
already selected.

STEP 5: Click Change.

Figure 7.3 To delete a slide

Figure 7.4 

Figure 7.5 
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STEP 6: Select an Entrance, Emphasis, Exit, or Motion Path animation effect.

New drop-down menus with default settings will appear at the top of the Custom 
Animation task pane.

To remove an animation effect:

STEP 1: Select the text or object on the slide 
you want to modify.

STEP 2: Select the Animations tab.

STEP 3: �Click Custom Animation in the 
Animations group. The Custom 
Animation task pane will appear on 
the right.

STEP 4:� Select the animation in the Custom 
Animation task pane list, if it is not 
already selected.

STEP 5:� Click Remove. The animation label will disappear from the slide and from 
the Custom Animation task pane list.

1. Animation - �Set of effects which can be applied to objects in PowerPoint so
that they will animate in the Slide Show.

2. Clipart - �Simple pictures and symbols made available for computer users to
add to their documents.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Explain to students the features and uses of PowerPoint.

• Open a blank slide screen and show the students how to add text in it.

Figure 7.6 
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• Show students how to add and delete any slide.

Student’s Notes
• Open a new slide and try to add different types of animation effects to it.

• 	�Create your first presentation by adding images and texts in different fonts and
styles in your presentation.

EXERCISE

1. Multiple Choice Questions

a) This holds the objects in your slide.
A) Placeholders B) Search

C) All programs D) Slide layout

b) The slide layout option _______
A) adds new slides B) arranges slide content

C) deletes old slides D) renames files

c) To delete a slide, we click on

A) Home button B) Delete command

C) Layout option D) Reset option

2. True or False
a) Slides appear in the center of the window. _________

b) A PowerPoint presentation is made of a series of videos. ______________

c) To create a new slide, we need to click on New Slide option. __________

3. Fill in the blanks
a) Title and content are an example of _______________________
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b) To add text in a blank slide, we click inside the ________________________

c) Delete command is placed in the slides group on the _________________tab.

4. Match the following
a) To change animation effect i)

b) To apply animation effect ii)

C) To delete a slide iii)

d) To remove an animation iv)

5. Very Short Answer Questions

a) What is the role of placeholders in a PowerPoint slide?
Ans.	 _________________________________________________________________________

b) Complete the following:
A slide layout ____________________________________________________________

6. Short Answer Questions

a) Write the steps to delete a slide.
Ans.	 _________________________________________________________________________

_________________________________________________________________________
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b) Write any one feature of PowerPoint.
Ans.	 _________________________________________________________________________

7. Long Answer Question

Write the steps to remove an animation effect in your slide.
Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question

Based on the screenshot given below, write the steps of the activity taking place 
in it.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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_________________________________________________________________________

_________________________________________________________________________

Activity
Perform the following steps for a fun-filled activity.

Open a PowerPoint document.

Save as “PowerPoint Practice”.

Choose a slide layout.

Fill in the slide with information.

Change the type and size of the letters.

Center the information.

Put a box around your information.

Give some animation effects of your choice to the slides. 

Save the presentation.
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Let Us Start

WRITING LOGO PROCEDURES8

Friends! So far, we have been giving 
one command after another to draw 

a picture in LOGO. If the drawing 
has got erased from the screen and 
you wanted it back once again, you 

would have to give allcommands 
again. Now, that would be very 

boring. Isn’t it?

The word ‘Procedure’ refers to a list of steps involved in doing a particular task. For 
example, when we boil water we need to follow an order.

STEP 1: We need to have a kettle.

STEP 2: Then we fill the kettle with water.

STEP 3: Place this kettle of water on a stove.

STEP 4: Light the stove.

STEP 5: Wait for the water to boil.

Before we move on to know about writing procedures in LOGO, let us recall 

what we have learnt in previous class.

Let Us Do1: Remember: 360/ number of sides= Angle of shape.

Example: 360/ 4= 90

REPEAT 4 [FD 100 RT 90]
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Now, complete the following and write the names of the shapes

	 REPEAT _____ [FD 100 RT _____] 	 REPEAT _____ [FD 100 RT _____]

 __________________________			   __________________________

	 REPEAT _____ [FD 100 RT _____]

 __________________________

We will learn 

• The concept of Logo procedures

• Create a new Logo procedure

• Save and load procedures

• Edit and delete

In this lesson

A LOGO Procedure is a way to make the turtle remember a set of commands. 
A procedure has a name saved in the computer’s memory. Once saved, the 
procedure can be used repeatedly.

For example, in order to draw a triangle, you will have to give the following 
commands to the turtle.

FD 120 RT 120

FD 120 RT 120

FD 120 RT 120

A triangle is a shape that can be used again and again to make other shapes 
and pictures. So, you might want to be able to recall these commands without 
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typing the whole command out. To do this, we could create a Procedure called 
‘traingle’. Let’s know more about the procedures.

Parts of a Procedure
1. �Title Line: The name of the procedure can include letters, numbers or symbols.

However, the beginning of the title must always be an alphabet. There should
be no blank spaces. Arithmetic operators also cannot be used. The most
important thing to be remembered is that LOGO command names cannot
be included.

2. Set of Instructions: This contains the actual set of commands.

3. 	�End Line: It contains the END command which marks the end of the procedure.

How to Create a Procedure?
Here we will learn two of the most common ways to start making a procedure. 

Below are the steps to create a procedure using the Input box.

STEP 1: Open the window of MSWLOGO.

STEP 2: Click in the input box. Now a cursor will start blinking in that box.

STEP 3: Type TO followed by the name of the procedure.

For example: You want to create a procedure to draw a rectangle.

Type TO Rectangle as shown below (Figure. 8.1). 

Figure 8.1

STEP 4:� After typing TO Rectangle in the Input Box, press 
the enter key or click the execute button.

STEP 5: The To Mode input box will appear.

STEP 6: �Enter the commands to draw a rectangle. Press 
the enter key after writing each command. Figure. 8.2
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STEP 7: �After entering all the commands, type the END command and press the 
enter key or click on the execute button.

STEP 8: Now as shown in the Figure 8.3. your procedure is defined for the Rectangular.

Figure 8.3

STEP 9: �In order to run the procedure,you will have to type Rectangle into the input 
box.

STEP 10: �Then click on the execute button or press the enter key. You will find 
a rectangular box.

Below are the steps to create a procedure using the Editor window. 

STEP 1: Open the Logo window. Click on the “File”option.

STEP 2: Under the “File” option, click on Edit.

STEP 3: The Edit Procedure dialog box will appear.

STEP 4: �Write Square and press the OK button. The  Editor 
window will appear (Figure 8.4)

STEP 5: Click at the end of To Square and then press the enter 
key to insert a blank line. Now enter the commands for the 
given procedure “square”.

TO SQUARE

RT 90 FD 90 RT 90 FD 90

RT 90 FD 90 RT 90 FD 90

END

STEP 6: After writing the commands, close the Editor window by 
clicking on the File menu. Under that, click on the Exit button

Figure 8.4

Figure 8.5

Figure. 8.6
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Save The Work in MSWLOGO
Every time you create and save a procedure, it becomes part of the current 
workspace. Saving a procedure does not put it on a disk. It exists only in 
memory until the entire workspace is saved.

The workspace is a collection of all the Logo procedures currently in memory. 
These workspaces can be saved and loaded, just like other documents.

Do You Know?

There are two methods to save a procedure on the disk.

1) Save command in Commander Input Box

STEP 1: Click on the Input Box to make it active. 

STEP 2: Type Save “Procedure Name" and press Enter.

2) Save command from File Menu

STEP 1: Click on File menu.

STEP 2: Select Save option.

STEP 3: Define name in File name box. 

STEP 4: Click on Save button.

The extension for a Logo file is .lgo

Loading a Procedure
Once the procedure is saved, it can be loaded anytime from the hard disk 
using Load command. Below are the steps:

STEP 1: Type LOAD “Procedure Name in the Input box and press Enter.

STEP 2: �Click on File > Load and select the disk or directory from where the file will 
be loaded. Click Open button.

Edit and Delete a Procedure

Editing a Procedure

Suppose you have created a procedure which you want to edit or correct. 

Figure. 8.7
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For Example: We want to make some changes to the procedure PENTAGON. 
When we made the PENTAGON procedure we kept the length of a side as 70 
and we now want to make it 90. Let us learn how to make changes in a 
procedure.
Steps for changing a procedure are as follows:

STEP 1: Open the Logo window. Click on the File option.

STEP 2: Under the File option, click on Edit.

STEP 3: �A dialog box will appear. Type the procedure name. The editor window will 
appear on the screen.

STEP 4: Make the Necessary corrections and Save again.

Deleting a Procedure

Suppose you want to delete a procedure that you saved earlier. For example: 

• 	�You want to delete a procedure called PENTAGON then type ERASEPENTAGON
into the input box.

• 	�For deleting all procedures you can type ERASEALL in the input box then
pressthe enter button. This command will erase all the procedures.

Let Us Draw a Grow Circle:
Try the following commands. To run this procedure, type GROWCIRCLE in the input 

box and press Enter.

TO GROWCIRCLE

REPEAT 36[FD 2 RT 10]
REPEAT 36[FD 4 RT 10]

REPEAT 36[FD 6 RT 10]

REPEAT 36[FD 8 RT 10]

1. Procedure: Refers to the method of doing a particular task.

2. Workspace: It is a collection of all the Logo procedures.

Glossary
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Inside the Lab:

  Teacher’s Notes
Familiarize the students with the concepts of loading, saving and editing procedures.

Student’s Notes
1. Draw a House

TO HOUSE

REPEAT 4 [FD 100 RT 90]

FD 100 RT 30

REPEAT 3 [FD 100 RT 120]

END

2. Draw a Hut

TO HUT

REPEAT 4 [FD 60 RT 90]

FD 60 RT 30 FD 60 RT 120

REPEAT 20 [BK 6 FD 66 BK 60 RT 3]

END

EXERCISE

1. Multiple Choice Questions

a) LOGO procedure consists of _____________ parts.
A) 4 B) 3

C) 1 D) 2

b) A file saved in LOGO will have ___________ extension.
A) .bmp B) .LOG

C) .png D) .LGO
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c) Which command erases all the procedures?
A) PENUSE B) ERASEALL

C) PU D) REPEAT

2. True or False
a) REPEAT command is used to load a procedure. ____________

b) We can create a procedure in 4 ways. _______________

c) A procedure can also be written in LOGO Editor window. _____________

3. Fill in the blanks
a)  To run a procedure, type the procedure name in the ____________________

and press Enter key.

b) _________________ command is used to recall a saved procedure.

c) 	�The name of a procedure can include _________________, ______________ or
symbols

4. Match the Following
a)			 i) REPEAT 360[FD 1 RT 1] 

b) ii) REPEAT 5[FD 100 RT 72]

C)			 iii) REPEAT 4[FD 60 RT 90 FD 120 RT 90]

d)			 iv) REPEAT 3[FD 100 RT 120]
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5. Very Short Answer Questions
a) Which command is used to delete a procedure?

Ans.	 _________________________________________________________________________

b) What is Endline?

Ans. _________________________________________________________________________ 

6. Short Answer Questions
a) How can you save a procedure? Explain any one method.

Ans.	 _________________________________________________________________________

b) What are the points that you should keep in mind while naming a procedure?

Ans.	 _________________________________________________________________________

7. Long Answer Question
Write the steps to create a procedure using input box.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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8. Picture Based Question
Write procedures to draw the below shapes.

i)			 ii)

ACTIVITY
Run these commands and see what happens. Draw the output in the given spaces.

a) REPEAT 5[FD 200 RT 144] b) REPEAT 12[RT 60 REPEAT 3[FD 30 RT 90]
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Let Us Start

FIRST STEP TO INTERNET 9

Hey friends, in the 
previous class we read 
about Internet and its 
uses. Let us learn more 

about it.

We know that through Internet we can communicate between different computers 
irrespective of how they are connected and where they are placed. So how does 
this happen?

Let Us Do 1: Name the following which are required to connect to internet. Which is 
hardware and which is software?

___________________ ___________________
In the previous class, we already learnt some important terms and the requirements 
for getting connected to the Internet.
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Let’s learn more here.

We will learn 

• More about Web Browser

• World Wide Web

• Search Engines

In this lesson

Web Browsers 
A web browser is a software program created as a simplified means to present 
and explore content on the World Wide Web. These pieces of content, including 
pictures, videos, and web pages, are connected using hyperlinks and classified 
with Uniform Resource Locators (URLs).

The first browser, named World Wide Web 
and later renamed Nexus, was invented by 
Tim Berners-Lee in 1990.

Do You Know?

Some of the common browsers used currently are Google Chrome, Microsoft 
Internet Explorer, Mozilla Firefox, Opera and Safari.

All browsers have a number of similar features to help you use the web such as:

• Forward and back buttons to move between pages.

• A history folder which stores details of recently visited web pages.

• A stop button if a page is taking too long to load.

• Favorites and bookmark options to store often visited pages.

• Options to cut, copy, paste, save and print elements of web pages.

Tim Berners-Lee
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Let Us Do 2: Find and circle the Web browsers from the following pictures:

World Wide Web
The World Wide Web (WWW or Web for short) is the part of the Internet that we 
access using a web browser. It consists of a large number of websites. A Website is 
a collection of related web pages that provides information on a subject. A web 
page is a smaller part of a large website that contains more specific information. 
Each website will normally consist of a number of web pages. A web page can 
contain text, images, video, animation and sound.

Accessing web pages

You can access a website or web page by typing its URL (Uniform Resource 
Locator) into the address bar of your browser. An example of a URL is http://www.
bbc.co.uk.

URLs will have the format ‘http’ and a domain (such as .uk). What goes in between 
is arbitrary, but often has the term “www”.

“https” is the secure version of ‘http’. When you use 
https, any data you send or receive from the web server 
is encrypted. For example, when banking online, https 
is used to keep your account details safe. Figure 9.1



82

Figure 9.2 Website Homepage

Most sites have a page that links the user to the other main areas of the site. This is 
called the homepage. It is basically the first page of a website.

Web pages are connected by hypertext links. When a link is clicked we are taken 
to another page which could be on another server in any part of the world.

Let Us Do 3: Write the names of five things that a web page can have.

Do You Know?
Your cursor turns to a hand when you 

move it over a hyper link.

1.

2.

3.

4.

5.



83

Search Engines
Surfing may be entertaining, but we often need to locate 
specific information relating to a particular topic. Software 
called a search engine is used in this case. A search engine is 
a program that is able to search through large quantities of 
text and other data, according to specific instructions that it has been given. 

The user enters ‘key words’ or phrases on the subject that they are 
interested in. The search engine searches its database looking 
for references to the key words. It then returns web pages with 
links to the relevant websites it found.

The search results are generally presented in a line of results 
called as Search Engine Results Pages (SERPs). The information 
may be a mix of web pages, images, and other types of files. 

The most popular or most visited websites are usually put near to the top of the 
results page.

Popular examples of search engines are Google, Yahoo!, Bing and Ask.

How to Search for Information?
We do not always have to know a website’s 
address in order to use the Internet. It is important 
to know how to search for information. For this, 
we can use the search engines. Let’s take an 
example:

1. 	�First in the address bar of your browser open
the search engine. We will take an example
of www.google.co.in :

2. 	�After typing in whatever we want to search, Click Search or press the Enter
key on the keyboard of your computer. Choose a few of the most specific
keywords or phrases to describe your topic.

Figure 9.3 Google Homepage
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Figure 9.4 Search Box

3. 	�Assess results. Search through the list of web pages to pinpoint
information.

4. 	�We may not always get the results we are looking for. So we will need to
play with searchable terms. Using more specific words in combination
helps.  We must be aware that not all websites that are found in the
results are appropriate to our search. We should not click on anything
that seems inappropriate, too good to be true, or dangerous. There
are many websites on the Internet that will mislead and try to take
advantage of beginners.

Figure 9.5 Search Results
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Google was originally known as Backrub.

Fun Fact

1. 	�Internet: technology by which computers around the world are connected
to share information.

2. 	�Webpage: A web page is a smaller part of a large website that contains
more specific information.

3. 	�Browsing: Going to different websites on the internet and looking around.

4. 	�Website: Website is a collection of related web pages that provides
information on a subject.

5. 	�Search Engine: a software system that is designed to search for information
on the World Wide Web.

6. 	�Web browser: a software program to explore content on the World Wide
Web.

Glossary

Inside the Lab
Let’s practice a little of what we just learnt.

  Teacher’s Notes
• Show the students how to connect to internet.

•  Explain to students the difference between a web page and a website
by opening them separately on the computer.

Student’s Notes
•  Open a web browser on your computer and the information related to your school.
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EXERCISE

1. Multiple Choice Questions
a) When a computer connects to ISP, the address assigned to it is called:

A) IP address B) URL

C) Pin address D) None of the above

b) 	�The search results in a search engine are presented in a line of results known
as:

A) SERPs B) ERLs

C) ISP D) www

c) First browser was later named as:

A) Google B) Nexus

C) Internet explorer D) Yahoo

2. True or False

a) Every URL starts with www. ____________

b) Search engine and web browser are the same. _____________

c) 	�Using more specific words in searching information will give better results.
_________________

3. Fill in the blanks

a) The full form of TCP/IP is _____________________________.

b) __________ is software used to search for information on the World Wide Web.

c) Your cursor turns to a ________________ when you move it over a hyperlink.
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4. Match the Following
a) Webpage i) www.google.co.in

b) Search Results

ii) 

c) Web Browser

iii) 

d) URL

iv) 

5. Very Short Answer Questions

a) Write the names of four search engines.

Ans.	 _________________________________________________________________________

b) What is SERP?

Ans.	 _________________________________________________________________________

6. Short Answer Questions

a) Differentiate between a website and a webpage with examples.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

b) Write a short note on TCP/IP Protocol.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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7. Long Answer Question

How do you search for specific information on the Internet? Explain with the help 
of examples.

Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

8. Picture Based Question

The following picture shows the search result of a website. Answer the following -

a) Which search engine is being used?

b) Name a word which has hyperlink.

c) What key word is being looked for?

d) 	�The search can be carried using which one of the four options – web,
image, video or map?
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Ans.	 _________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

Activity
Label the different parts of this URL: http://www.yahoo.com
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Let Us Start

INTERNET ETIQUETTE AND SAFETY 10

Hey Friends, in 
the last lesson we 

learnt about how to 
connect to Internet 

and search for 
information.

In the last lesson, we have seen that how internet has become a very important 
part of our life. We regularly use Internet to keep in touch with family and friends, 
check our mail and to search for information. 

Let Us Do 1:  Name the following different ways we communicate with each 
other using internet.

_______________ _______________ _______________
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We will learn the rules and safety measures to be followed while using internet.

In this lesson

What is Netiquette?
We follow certain rules to live in this world. In a similar 
way, internet has certain rules that the people must 
follow.
Netiquette, or net etiquette or internet etiquette, 
refers to the unwritten rules of good behavior online. 

Good netiquette involves respecting others’ privacy 
and not doing anything online that will annoy or frustrate 
other people. Three areas where good netiquette is 
highly stressed are e-mail, online chat, and newsgroups.
There are some great rules for netiquette that will make our online experience 
more enjoyable:

• �The first rule of Internet etiquette is to never use impolite or offensive language
in emails, in posts, on websites, on forums, in social media, etc.

• 	�Show respect for the opinions of others, even if you don’t agree. Avoid saying
anything negative about others.

• �Avoid using all caps in any email or post. It is not only difficult to read, it comes
across as shouting, which is rude.

• 	�Do not post, copy or distribute copyrighted material to which you do not own
the rights. Give credit, cite the source, and put a link to the complete written
work.

• 	�Don’t gossip and keep personal information personal. Don’t tell stories that you
don’t know for a fact to be true.
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Plagiarism is taking another person’s writing, conversation, song, or even 
idea and passing it off as your own without their consent. It is an offence. 

Do You Know?

• 	�It is always a good idea to reread anything you type before clicking the “send”
button.

• 	�Hacking and breaking into other peoples’ computers or networks is a criminal
offence.

• 	�Don’t spam. That is, don’t repeatedly post the same content such as
advertisements for products or services.

• Remember cyber bullying is a crime.

Cyberbullying is the use of Internet and cell phones to make 
another person feel angry, sad, or scared again and again. 
Examples of cyberbullying include sending messages that hurt, 
posting inappropriate photos or videos on social media, and 
spreading mean rumours online.

The fundamental rule must be that we should never do things in 
the virtual world that we wouldn’t do in everyday life.

Let Us Do 2: Write 3 things that come under copyright information.

1

2

3
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Safety Measures While Surfing the Internet
Internet is a great place full of information, but it is also full of 
many dangers. Let’s have a look at some safety measures 
that we should follow while surfing internet or browsing sites. 

1. Protecting our Identity

a) �Personal Information: Don’t give out personal information
without your parents’ permission. This means that we
should not share our last name, home address, school name, photographs or
telephone number.

b) �Password: Keep strong passwords. Don’t share them with anyone but your
parents. Make sure you logout of the accounts you’ve accessed before leaving
the terminal.

c) �Photos: Don’t post photos or videos online without getting your parents’
permission.

d) �Online Friends: Don’t agree to meet an online friend unless you have your
parents’ permission. Unfortunately, sometimes people pretend to be people
they aren’t. Remember that not everything you read online is true.

e) �Online Ads. Don’t buy anything online without talking to your parents. Some ads
may try to trick you by offering free gifts or prizes as a way of collecting your
personal information.

f) �Beware of phishing e-mails – These emails claim to be from a reputed company
or a bank and ask for personal or sensitive information.

g) �Bullying. Don’t send or respond to mean or insulting messages. If something
happens online that makes you feel uncomfortable, talk to your parents or to a
teacher at school.

2. Protecting our connection

a) �Use an anti-virus program, an anti-spyware program, and a firewall. Surfing the
internet without these things is unsafe and invites spam, hackers, and viruses
onto your computer. Make sure to keep them updated to catch the latest
threats.
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A firewall is a hardware or software that creates a barrier between your 
network and the outside cyber world, allowing only certain data to cross.

Do You Know?

b) 	�Downloading: Email attachments or softwares
may sometimes contain viruses. Never open an
attachment from someone you don’t know.

c) �Download files from trusted sources. Always check
with your parents before downloading or installing
software that could possibly damage your computer.

Secure sites may have a gold lock at the bottom of the 
page. When giving any bank details or other information, 
make sure the connection is secure.

Secure URLs begin with https:// instead of http://. 

Let Us Do 3:  Write 5 things that come under your private information.

1

2

3

4

5
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�1.  Copyright: A legal right created by the law of a country that grants the
creator of an original work rights for its use and distribution. .

2.  Hacking : A unauthorized intrusion into a computer or a network. The person
engaged in hacking activities is generally referred to as a hacker.

3.  Spam: Is	flooding	the	Internet	with	many	copies	of	the	same	message.

4. Phishing: A technique used to gain personal information for purposes of
identity theft, using fraudulent e-mail messages that appear to come from
legitimate businesses.

5. Virus: A computer program designed to cause damage, steal personal
information, modify data, send e-mail, display messages, or some
combination of these actions.

6.  Spyware: As oftware that aims to gather information about a person or
organization without their knowledge.

7. HTTP: Stands for Hypertext Transfer Protocol. It is the set of rules for transferring 
files	 (text,	 graphic	 images,	 sound,	 video,	 and	 other	multimedia	 files)	 on
the World Wide Web.

Glossary

  Teacher’s Notes
• Tell the students about netiquette and its importance

• 	�Explain to the students the importance of securing personal information and
not sharing it online.

Student’s Notes
• Prepare a chart of netiquette and stick it in your classroom

•  Discuss with your teacher the different safety measures that you follow when
you use the Internet.
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EXERCISE

1. Multiple Choice Questions

a) The rules that we follow while on Internet are called:
A) Netiquette B) Safety Rules

C) Etiquette D) Emoticon

b) The act of taking someone else’s idea and passing them off as one’s own is:
A) Copying B) Plague

C) Plagiarism D) Phishing

c) �A software that aims to gather information about a person or organization
without their knowledge is called

A) Spyware B) Firewall

C) Virus D) Antispam

2. True or False
a) We should never give out our passwords to anyone. __________

b) We	can	download	files	from	anywhere.	__________

c) Using all caps in any email or post is considered rude. ___________

3. Fill in the blanks
a) 	�The destructive computer programs that affect our computer and damage

it are called _____________________.

b) 	�The person engaged in  hacking activities is generally referred to as a
______________.

c) A representation of a facial expression such as a smile or frown is called
___________________.
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4. Match the following:
a) Virus i) legal right for use and distribution of work

b) Copyright ii) gathers personal information without knowledge

c) Spam ii) damage and steals personal information

d) Spyware iv) flooding internet with same message

5. Very Short Answer Questions
a) What is the full form of HTTP?

Ans.	 _________________________________________________________________________

b) Which of the following is a secure site?

https://www.flipkart.com/

http://www.flipkart.com/

Ans.	 _________________________________________________________________________

6. Short Answer Questions
a) Define plagiarism.

Ans.	 _________________________________________________________________________

	 _________________________________________________________________________

b) What	is	firewall?

Ans.	 _________________________________________________________________________

	 _________________________________________________________________________
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7. Long Answer Question
Write	down	five	safety	measures	to	use	while	surfing	Internet.

Ans.	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

8. Picture based Question

a) Someone continuously sends a mail like this. What is it called? Define it.

Ans. _________________________________________________________________________ 

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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b) What is the hand pointing to? Explain.

Ans.	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

ACTIVITY
Tick the activities that are considered safe and nice while using Internet.

Do not respond to any message that makes you feel 
uncomfortable.

Say anything you want about anyone even if it’s not nice.

Never share your picture with anyone without checking with your 
parents.

Share stuff that you found online without knowing if it’s true or not.

Do not believe everything that you see on the Internet.



Notes:
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FAMOUS PEOPLE 

Personalities
Theodor Seuss Geisel (March 2, 1904 – September 24, 1991): 
He was an American writer and illustrator. He was best known 
for authoring popular children’s books under the pen name Dr. 
Seuss. His works include several of the most popular children’s 
books of all time. Over 600 million copies were sold and his 
works were translated to over twenty languages.

Some of Dr. Seuss’ famous books are given in column A. Match them with 1 their 
dates of publication given in column B.

Column A Column B

1) a) August 12, 1960

2) b) December 21, 1937

3) c) October 12, 1950

4) d) March 12, 1957

1
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Dr. Seuss won two Academy Awards – one for his animated short story ‘Gerald 
McBoing-Boing’ and the other one for his documentary on Japanese culture 
called ‘Design for Death’.

Do You Know?

Sunita Williams (September 19, 1965): She is an American 
astronaut and United States Navy officer of Indian-Slovenian 
descent. She holds the records for total spacewalks by a 
woman (seven) and most spacewalk time for a woman (50 
hours, 40 minutes).Williams was assigned to the International 
Space Station as a member of Expedition 14 and Expedition 
15. In 2012, she served as a flight engineer on Expedition 32
and then commander of Expedition 33.

Find out the duration of each expedition.

1) Expedition 14	 : __________________________________________________

2) Expedition 15	 : __________________________________________________

3) Expedition 32	 : __________________________________________________

4) Expedition 33	 : __________________________________________________

Margaret Thatcher (13 October, 1925 – 8 April, 2013): She was a 
British politician, who was the Prime Minister of the United Kingdom 
from 1979 to 1990, and the Leader of the Conservative Party from 
1975 to 1990. She was the longest-serving British Prime Minister of 
the 20th century and is currently the only woman to have held the 
office. A Soviet journalist dubbed her the “Iron Lady”, a nickname 
that became associated with her uncompromising politics and 
leadership style. As Prime Minister, she implemented policies that 
have come to be known as Thatcherism.
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Find out more about Margaret Thatcher by finding answers to these questions.

1) When was Margaret Thatcher born?

Ans.	 _________________________________________________________________________

2) Why was Margaret known as the ‘Milk Snatcher’?

Ans.	 _________________________________________________________________________

3) Who nicknamed Margaret the ’Iron Lady’?

Ans.	 _________________________________________________________________________

4) Which country awarded her the ‘Presidential Medal of Freedom’?

Ans.	 _________________________________________________________________________

5) Under Margaret’s rule, which war was won by the British troops?

Ans.	 _________________________________________________________________________

Henry Ford (July 30, 1863 – April 7, 1947): He was an American 
industrialist, the founder of the Ford Motor Company, and the 
sponsor of the development of the assembly line technique of 
mass production. It marked the beginning of the second industrial 
revolution. Ford developed and manufactured the first 
automobiles that many middle class Americans could afford. 
Thus, automobiles were no more a luxury reserved only for the 
rich. They came to be purchased and used by common people.

This is Ford’s revolutionary Model T car. Can you find 
out some of the salient features of this car?

_______________________________________________

_______________________________________________

_______________________________________________

_______________________________________________

______________________________________________________________________________
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Find out about the Assembly line of production introduced by Ford.

_________________________________________________________

_________________________________________________________

_________________________________________________________

_________________________________________________________

______________________________________________________________________________

Steve Jobs (February 24, 1955 – October 5, 2011): He was 
an American information technology entrepreneur and 
inventor. He was the Co-Founder, Chairman, and Chief 
Executive Officer (CEO) of Apple Inc.; CEO and largest 
shareholder of Pixar Animation Studios; a member of The 
Walt Disney Company’s board of directors and founder, 
chairman, and CEO of NeXT Inc. Jobs is widely recognized 
as a pioneer of the microcomputer revolution of the 1970s, 
along with Apple co-founder Steve Wozniak. During his 
early career in 1973, Steve Jobs worked as a technician for 
Steve Woznaik. At the time he was living a simple life in a 
cabin working at Atari and saving money for his planned 
trip to India. His hard work and dedication earned him the deserved success. 
Shortly after his death, Jobs’s official biographer, Walter Isaacson described him 
as, “the creative entrepreneur whose passion for perfection and ferocious drive 
revolutionized six industries: personal computers, animated movies, music, phones, 
tablet computing, and digital publishing.”

You must have seen few of those many animated films produced by Pixar and 
Disney. Some of the pictures of renowned animated movies are given in the box 
below. Find out the names of those movies which have been produced by Pixar – 
Disney and write their names in the space provided.
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1) 2) 3)

4) 5) 6)

7) 8) 9)

10)

Ans.	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________

	 _________________________________________________________________________
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William Henry “Bill” Gates III (born October 28, 1955): He is an 
American business magnate, philanthropist, investor, and 
computer programmer. In 1975, Gates and Paul Allen co-
founded Microsoft, which became the world’s largest PC 
software company. During his career at Microsoft, Gates held 
the positions of chairman, CEO and chief software architect, 
and was the largest individual shareholder until May 2014. Gates 
has authored and co-authored several books. He is considered 
to be the wealthiest person in the world.

Bill Gates has authored and co-authored several famous books. Complete the 
names of some of these books given below.

1) The __________________________ Optimist.

2) The Road ______________________.

3) ____________________________ for life.

4) Business @ the _____________________________________.

Bill Gates, Walt Disney, Abraham Lincoln, Henry Ford, Steve Jobs, Mark 
Zuckerberg and Thomas Edison have no college degrees.

Fun Fact
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CONSERVING NATURE

Forestry
Among the most valuable of nature’s resources, forests are 
very important. They play a key role in the maintenance of the 
watersheds that are essential to sustain ground water and soil 
conservation. They shelter many forms of wildlife. Forests also 
do a lot of good to the atmosphere in climate control, as well 
as supplying oxygen for human sustenance.So, the need to 
protect and develop them can never be stressed enough.

Multiple Choice Questions

1) 	�Which of the following international organizations works on
issues regarding conservation, research and restoration of
the environment?� [      ]
(A) World Wildlife Fund (B) World Bank
(C) UNESCO (D) Save Tiger Now

2) 	�Project Tiger, a programme to maintain a viable population
of tigers in India and to chalk out areas for their habitat, was
launched in the year:� [      ]
(A) 1975 (B) 1971
(C) 1974 (D) 1973

3) 	�We all know, that the Kaziranga Sanctuary is a place where rhinos can live
safely away from hunters. What is the term used for such careful use and
protection of nature?� [      ]
(A) Biofriendly (B) Ecofriendly
(C) Degradation (D) Conservation

4) What is the natural environment of a living organism called? [    ]
(A) Habitat	 (B) Surroundings
(C) Environment	 (D) Biosphere

2
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5) 	�What is the process of collecting, processing and reusing waste
materials called?� [      ]
(A) Reworking	 (B) Recycling
(C) Reusing	 (D) Reprocessing

6) Which one of the following has maximum genetic diversity in India?� [ ]
(A) Tea	 (B) Teak 	 (C) Wheat (D) Mango

7) �The Giant Panda is the official symbol of the World Wide Fund for Nature. In
which country is this animal found?� [      ]
(A) China	 (B) India
(C) Myanmar	 (D) New Zealand

8) 	�Many scientists think that the increased levels of
__________________ in the atmosphere is causing Global warming.� [ ]
(A) Nitrogen	 (B)Carbon Dioxide 	 (C) Hydrogen	 (D)Oxygen

Match the images of the animals that are at threat of being extinct, with their 
respective names.

1)

Snow Leopard

2)

Saola

3)

The lion tailed macaque

4)

The Indian Rhinoceros
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Bandipur National Park, Nagarhole National Park (in Karnataka), Mudumalai 
National Park (in Tamil Nadu) and Wayanad Sanctuary (Kerala) together 
form the Nilgiri Biosphere Reserve which is the largest Biosphere of India.

Do You Know?

Match these famous animal and bird sanctuaries to the places where they are 
located.

Column A Column B

1) Gir National Park a) Kerala

2) Manas Wildlife Sanctuary b) Odisha

3) Sunderbans National Park c) Madhya Pradesh

4) Corbett National Park d) Gujarat

5) Periyar National Park e) Assam

6) Chilka Bird Sanctuary f) Rajasthan

7) Tal Chappar Wildlife Sanctuary g) West Bengal

8) Bandhavgarh National Park h) Uttarakhand

Ranthambore National Park was declared a Wildlife Sanctuary in 1955 and it 
got its status of a National Park in the year 1980.

Do You Know?
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All about Natural Resources
Natural Sources of Water

Multiple Choice Questions

1) Which is the longest Indian River? [     ]

(A) Godavari (B) Ganga	 (C) Brahmaputra	 (D) Yamuna

2) 	�Which river descends over a cliff to form the famous BharChukki and
GaganaChukki Falls? [      ]

(A) Tungabhadra (B) Krishna	 (C) Kaveri	 (D) Narmada

3) On which river is the holy shrine of Pandharpur situated? [ ]

(A) Krishna	 (B) Ravi	 (C) Godavari (D) Bhima

4) 	�One of the oldest and holiest Indian cities lies on the banks of the river
Shipra. What is its name? [    ]

(A) Ujjain (B) Gandhinagar	 (C) Chandipur	 (D) Mysore

5)
[      ]

 Which river is believed to be the daughter of the Mountain
King, Himavat?
(A) Krishna (B) Ganga (C) Godavari (D) Kaveri

6) Name the river whose main tributary is Tungabhadra. [     ]

(A) Krishna	 (B) Godavari	 (C) Kaveri (D) Narmada

7) Which river is often called the ‘Southern Ganges’? [    ]

(A) Godavari	 (B) Krishna (C) Sarayu	 (D) Kaveri

8) 	�Which river joins the river Ganga at Prayag? [ ]

(A) Godavari	 (B) Krishna (C) Yamuna	 (D) Kaveri
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Identify the pictures of some famous rivers across the globe.

______________________________
flows in North eastern Africa, 

longest river in the world)

______________________________
(situated in England, longest 
river in England and second 

largest in the UK)

______________________________
(longest river of Asia and 

situated in China)

______________________________
(river in South America)

______________________________
(Major river flowing in South-

Asia)

______________________________
(2nd longest river of Europe)
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Interesting Facts about Oceans and seas:
• The Pacific is the largest and the deepest ocean in the world.

• �Dead Sea is so salty because it is surrounded by a hot desert. The intense
heat causes sea water to evaporate faster, thus large quantities of salt
remains in the sea as water goes into the air.

• �The Red Sea in the Indian Ocean is one of the saltiest water body. The
Red Sea got its name from the explosive growth of a blue alga that dyes
the normally blue water an orange red.

• �Dead Sea (also known as Salt Sea) puts lot of upwards force due to large
quantity of salt in it, so people can remain afloat in this or can swim with
no effort.

• �The Indian Ocean is the warmest ocean. The temperature of surface
water sometimes touches 36.6 degrees.

• �Do you know? “Pacific means “peaceful”. Actually when people first
found it, they found it very calm & peaceful, so they named it “Pacific”.

Renewable Sources of Energy

Look at the image and identify the different sources of energy.

1) 	�The energy from the sun is called ________________________ Energy.

2) 	�The sun provides us with__________________and ___________________.

3) ____________________Energy is used to generate electricity using solar panels.

4) 	�The energy from the wind is called ________________________ Energy.

5) 	�Wind is converted to electricity with the help of
_______________________.

6) 	�Wind is a ________________________ resource, because it is not
limited.

7) 	�Water energy is also called ________________________.

8) 	�Water is now used to produce ________________________.

9) ________________________ are constructed in order to produce electricity
using water.
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Plants use Sun’s energy to make their own food by the chemical reaction 
called Photosynthesis. Hence, when we eat fruits and vegetables, we are 
actually getting calories from the Sun.

Fun Fact
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SCIENCE AROUND US

Health and Diseases
Read the symptoms of a disease and guess the disease. Use 
the below Word Bank below to help you.

Chickenpox Fever Conjunctivitis Diarrhea

WordBank

1)  Rise in body temperature above 37oC, sometimes accompanied
by cold and sore throat.

Ans. _____________________________________________________________

2) 	�An infectious disease causing mild fever and a rash of itchy
inflamed pimples that turn in to blisters. It lasts about two weeks
and is communicable in nature.

Ans. ______________________________________________________________

3) 	�Disease caused due to food poisoning. One gets loose motions and
will have less to no appetite. Body becomes weak and dehydrated.

Ans. ______________________________________________________________

4) 	�This disease affects the eye and is also called as ‘Pink Eyes’. It affects the outer
layer of the eye and the inner surface of the eyelids. It causes irritation, pain and
itchiness in the eye. It is communicable.

Ans. _________________________________________________________________________

3

Gk Grade 5.indb   14 09/02/17   7:25 pm



15

Identify the following diseases as communicable or non-communicable diseases

1) Flu : ________________________________

2) Cancer : ________________________________

3) Diabetes : ________________________________

4) Measles : ________________________________

5) Hyper tension	 : ________________________________

6) Rabies : ________________________________

7) Tuberculosis	 : ________________________________

8) Hepatitis : ________________________________

9) Asthma : ________________________________

10) HIV/AIDS : ________________________________

11) Leprosy : ________________________________

12) Kala Azar : ________________________________

13) Typhoid : ________________________________

One in eight deaths in the world is due to Cancer. Cancer causes more 
deaths than AIDS, Tuberculosis and Malaria combined.

Do You Know?
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Learn About Body Joints
From the below picture learn about the various body joints of our bodies.

The funny bone in human body is not at all a bone. It is actually a nerve 
known as ‘Ulnar Nerve’. The Ulnar Nerve lets our brain know about the 
feelings in our fourth and fifth fingers.

Fun Fact
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Medical Electronics
Look at the image and identify the various machines used in a hospital.

	 _______________	 ____________________	 ___________________

	 _______________	 ____________________	 ___________________
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GREEN EARTH

Grouping Plants
Evergreen or Deciduous?

Evergreen trees, as the name suggests have leaves throughout the year. On the 
other hand, deciduous trees lose all their leaves in autumn, becoming completely 
bare.

Complete the names of the evergreen and deciduous trees. Use the Word Bank for 
help.

Juniper	 Aspen	 Pine	 Maple	 Oak	 Beech

Eucalyptus	 Spruce	 Birch	 Fir	 Hemlock	 Poplar

WordBank

Evergreen Trees Deciduous Trees

P ___ ___ e M ___ ___ l__ 

E ___ c___l ___ ___ t___ s ___ i___ ___ h

F ___ ___ A ___ ___ ___ n

___ u___ I ___ ___ r ___ a ___

S ___ ___ ___ c___ P ___ p___ ___r

___ ___ m ___ o___ ___ B ___ e ___ h

4
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Carnivorous Plants

Write the names of the Carnivorous plants from their given descriptions. Use the 
Word Bank for help.

Venus Fly Trap	 Butterwort	 Nepenthes	 Drorsera	 Sarracenia
WordBank

1) 	�They are often called Sundews. They attract unsuspecting
insects with this “Dew” and are able to ensnare and even
digest their prey.

Ans.	 ______________________________________

2) 	�They are known for their hinged, leafy “jaw” that snaps together
to trap and consume unsuspecting insects or small prey.

Ans.	 ______________________________________

3) 	�They are also known as tropical pitchers because of their pitcher
like shape and are carnivorous plants native to tropical habitats
in Australia, Asia and Sri Lanka.

Ans.	 ______________________________________

4) �They look similar to normal flower species and for this reason,
they often fool their prey and people. Found mostly in North
America and Canada.

Ans.	 ______________________________________

5) 	�Large group of carnivorous bog plants that trap and digest
insects in a sticky secretion on their leaves. They bear single
white, purple or yellow flowers on a leafless stalk.

Ans.	 ______________________________________
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Multiple Choice Questions

1) What do carnivorous plants eat? [    ]

(A) Arachnids and insects (B) Steering Wheels

(C) Dead Ants (D) Carcass

2) How many species of carnivorous plants are there? [    ]

(A) More than 17 (B) Less than100

(C) Around 150 (D) More than 750

3) ]In which of the world’s locations are carnivorous plants not found? [ 

(A) Asia (B) Antarctica

(C) Iceland (D) Arctic

Scientists found a carnivorous plant called a pitcher lant in Philippines. It is so 
large that it can trap rats.

Do You Know?

Plant Processes
Complete the crossword with the help of the clues provided.

Across: Down:
2) � The process of metabolizing 

(burning) sugars to yield energy for
growth, reproduction and other
life process.

1)  �The transfer of pollen grains is called
_______________.

5)  �The loss of water vapor through
the stomata of leaves.

3)  �The process of capturing light energy
and converting it to sugar energy, in the
presence of chlorophyll using carbon
dioxide (CO2) and water (H2O).

6)  �A change in a plant’s structures of
behaviour that helps it survive.

4)  �The sprouting of a plant.
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1

2 3

4

5

6

Gk Grade 5.indb   21 09/02/17   7:25 pm



22

ANIMAL PLANET

Riding the Food Chain
Multiple Choice Questions

How does energy flow through the ecosystem?

1) 	�Which food chain correctly describes the flow of energy in an
ecosystem? [   ]

(A) Grass  goat  human	 (B) Caterpillar  leaf  human

(C) Cow  grass  human	 (D) Leaf  bird  caterpillar

2) 	�Rabbits eat grass and other plants to survive, but they do not eat animals.
What kind of animals are rabbits?� [ ]

Rabbit	 Fox

(B) Carnivores

	



 (D) Herbivores

5
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3) 	�How do decomposers help other organisms in an ecosystem?� [ ]

(A) �They break down dead organisms and add nutrients back to the soil
that plants use.

(B) �They use the sunlight to make their own food that other organisms eat for 
energy.

(C) They help disperse seeds for plant growth.

(D) Decomposers do not help other organisms in an ecosystem.

4) 	�In what order do a hawk, grass, and rabbit form a food chain in a
meadow?� [      ]

(A)Hawk  grass  rabbit

(B)Grass  hawk  rabbit

(C)Rabbit  grass  hawk

(D)Grass  rabbit  hawk

5) Which of the following lists only consumers? [    ]

(A)Hawks, lizards, chipmunks (B)Acorns, squirrels, rabbits

(C)Grass, chipmunks, eagle (D)Mice, squirrels, grass

6) 	�A wood mouse eats leaves for food. A badger eats wood mice for food.
Which animal is the prey in this food chain?� [ ]

(A)Badger	 (B) Wood mouse

(C)Neither Animal	 (D) Both the animals
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Food Chain Vocabulary

Use the correct words below in the Word Bank to complete the following 
sentences.

Producer	 Species	 Energy	 Decomposition	 Plant

WordBank

1) 	�The food chain shows the transfer of _________________ from one species to
another.

2) 	�An example of a forest food chain could be: pine nut (from
a tree): squirrel: fox: bacteria. In this example, the food chain
ends with ________________________.

3) A ______________ is a producer.

4) A __________________ is an organism that makes its own food.

5) 	�The length of a food chain is measured by the number of _______________
encountered as energy moves from the autotroph to the top consumers.

Within a food chain, some living things create the energy (Producers) and 
some use the energy (Consumers).

Do You Know?

Canine Companions
The dog is one of the most popular pets in the world. This is because dogs help 
man out in so many ways. Dogs have long played an important role in the lives 
of humans through their sharp senses. They are also known to be a therapeutic 
company. Dogs are often called ‘Man’s Best Friend’.
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Multiple Choice Questions

1) 	�This is a big dog that is very friendly. It is a good swimmer, and may rescue
you from water when you are in trouble. This dog has a long, shaggy coat
that comes in three main colours.� [      ]

(A) Labrador Retriever (B) Afghan Hound

(C) Old English Sheepdog (D) Newfoundland

2) 	�Which of the following breeds of dogs is NOT a true
terrier? [    ]

(A) Tibetan Terrier (B) Border

(C) Yorkshire Terrier (D) Kerry Blue Terrier

3) Which breed of dog is the fastest on earth? [    ]

(A) Great Dane (B) Greyhound

(C) Border Collie (D) Borzoi

4) 	�What is the favourite dog breed of the Queen of
England? [    ]

(A)Corgi (B) Basenji

(C)Poodle (D) Pomeranian

5) Which dog breed is the smallest of them all? [    ]

(A) Dachshund (B) Shih Tzu

(C) Pomeranian (D) Chihuahua
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Can you name all the dog breeds? Use the below word bank with dog names to 
help you.

Papillion	 French	 Bulldog	 Poodle	 Pomeranian

Doberman	 Pug	 German	 shepherd

WordBank

________________

________________

________________

________________

________________

________________

________________

Read each statement and tick it as True/ False.

1) 	�The oldest breed of dog is the beagle. (True/False)

2) 	�There is at least one dog breed and one cat breed that is
hairless. (True/False)

3) 	�Dalmatians are born with spots. (True/False)

4) 	�Dogs can only see in black and white. (True/False)

5) 	�Labradors are the most popular breed in the United States. (True/False)
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• 	�The tallest living dog is a 1.18 m tall Great Dane.

• 	�The first animal in space was a dog! The first live animal to go into space
was not an astronaut, but was actually a dog! Laika, a Russian dog
orbited the earth in the Russian Spacecraft Sputnik in 1957.

Do You Know?

Dogs are capable of understanding up to 250 words and gestures. Dogs 
can count up to five and can perform simple mathematical calculations.

Fun Fact

Night Hunters
Some animals are nocturnal. This means that they come out at 
night time when it is dark.

Can you unscramble the animal words below and match with their images?

1) w l o __________________

2) x o f __________________

3) d t o a __________________

4) s k n u k __________________
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5)	 o u m e s	 __________________

6) n r o c c a o	 __________________

Multiple Choice Questions

1) Many nocturnal animals have big eyes that let in more __________.� [ ]

(A) Water	 (B) Sunshine	 (C) Light	 (D) Colour

2) 	�Some _________________ are afraid of nocturnal animals. [    ]

(A) Insects	 (B) People	 (C) Apple (D) Cars

3) 	�Nocturnal animals are more active at night because they can see better
in the __________.� [ ]

(A) Dark	 (B) Future	 (C)Daylight	 (D) Space

4) 	�Many people haven’t ever seen a bat up close, even though bats _________
in most countries in the world.� [      ]

(A) Talk	 (B) Smell	 (C) Live	 (D) Eat

Owls are sometimes a symbol of learning. Libraries and bookstores sometimes 
use pictures of owls to represent reading or wisdom.

Do You Know?

Owls can’t move their eyes. They must turn their heads to see. Owls can turn 
their heads almost completely around.

Fun Fact
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FUN WITH SPORTS

Sports Masters
Below are pictures of some of the greatest cricketers of the world. Identify them 
and write the names of their country of origin.

1) 2)

___________________ ___________________

3) 4)

___________________ ___________________

5) 6)

___________________ ___________________

Fill in the blanks by choosing the correct option.

1) 	�Sir Viv Richards was the captain of a ___________________________ team.
(football/cricket)

2) 	�George Armstrong was the captain of a ___________________________ team.
(ice hockey/cricket)

6
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3) 	�Imran Khan was the captain of a ___________________________ team.
(football/cricket)

4) 	�Willie John Mc. Bride was the captain of a _________________________ team.
(football/rugby)

5) 	�Don Bradman was the captain of a ___________________________ team.
(football/cricket)

6) 	�Bobby Moore was the captain of a ___________________________ team.
(football/cricket)

7) 	�Bobby Clarke was the captain of a ___________________________ team. (ice
hockey/cricket)

8)  MS Dhoni was the captain of a ___________________________ team. (football/
cricket)

9) 	�Martin Johnson was the captain of a ___________________________ team.
(rugby/cricket)

Sir Viv Richards never lost any cricket test series as a captain.

Do You Know?

Let’s Learn Sports!
Identify the names of these games/sports from their descriptions. Choose the 
names from the box below.

Go Karting	 Javelin Throw	 Bungee Jumping

All-Terrain Vehicles	 Paintball	 Frisbee	 Bowling

WordBank
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1) 	�In this game, the person runs for a certain distance to gain
momentum and then throw the spear (javelin) which is
about 2.5 metres long. ____________________________

2) 	�This is a car racing game, where the four wheeled
small vehicles known as go-karts races on fixed tracks.
____________________________

3) 	�This is an activity which involves jumping from a tall
structure while he/she is connected to a long elastic
cord. ____________________________

4) 	�These All-Terrain Vehicles are generally used for
adventurous purposes to discover unknown terrains. In
most countries, they are not allowed to ply on streets.
____________________________

5) 	�This game is either played individually or in teams.
Each party tries to eliminate the opponent by tagging
them with balls containing colours driven from a device
called Paintball Gun. ________________________

6) 	�In this game, the bowler has to knock down as many pins
as possible by rolling down the ball from a long narrow lane.
____________________________

7) 	�This game is played with a disc. To score points the disc
has to be passed to a team member in the opposing
end zone. ____________________________
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Before entering the world of International Cricket, Dhoni worked as a ticket 
collector at the Kharagpur Railway Station to support his family while he 
continued representing Bihar in the Ranji Trophy.

Fun Fact

Guess the Stadium
Identify these famous stadiums of the world from the descriptions given below. 
The names of the stadiums are also provided in the box below.

Camp Nou	 Allianz Arena	 National Stadium	 Ericsson Globe	 Wembley

Soccer City	 Salt Lake Stadium	 National Stadium	 Beijing

WordBank

1) 	�It is the biggest stadium in Europe, built in a retro-style. It
is located in Barcelona, Spain.

Ans. _______________________________________

2) 	�This is the second largest stadium in Europe. It has
been built by HOK Sports and Foster and Partners.
It has a partial retractable roof with an arch of 134
metre height.

Ans. _______________________________________

3) 	�It is the largest stadium in the African continent with a
capacity of 94, 700 people. The Football (FIFA) World
Cup 2010 was held here

Ans. _______________________________________
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4) 	�This stadium is situated in Kaohsiung, Taiwan. It is the
first stadium in the world to use solar energy to meet its
power requirements.

Ans. _______________________________________

5) 	�This stadium is in the shape of a globe and is the largest
hemispherical building in the world. It is mainly used for
playing ice hockey.

Ans. _______________________________________

6) 	�This stadium is located in Beijing, China and has a
capacity of 80,000 people. It has been built by Swiss
architectural firm and looks like a bird’s nest.

Ans. _______________________________________

7) 	�This stadium is the first stadium in the world to change
colour according to the team which is playing. It is
opened in the year 2005 and is located in Munich,
Germany.

Ans. _______________________________________

8) 	�This is the largest stadium of India by capacity, located
at Bidhannagar, West Bengal. It is also known as ‘Yuva
Bharati Krirangan’.

Ans. _______________________________________
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ENTERTAINMENT CORNER

Books and Their Authors

Match the names of the famous books given in column A with the names of their 

respective authors given in column B.

Column A Column B

1) Geetanjali a) Charles Darwin

2) A tale of two cities b) Jonathan Swift

3) The merchant of Venice c) E.M. Forster

4) Origin of species d) Jane Austen

5) A passage to India e) Arthur Conan Doyle

6) Gulliver’s Travels f) William Shakespeare

7) Pride and Prejudice g) Charles Dickens

8) Akbar - Nama h) Rabindra Nath Tagore

9) Adventures of Sherlock Holmes i) Lewis Caroll

10) Alice in Wonderland j) Rudyard Kipling

11) Adventures of Tom Sawyer k) Sir Richard Burton

12) Jungle Book l) Abul Fazal

13) The Arabian Nights m) Mark Twain

Toon Creators
The pairs of cartoons and their creators are given in the box below.

Choose the correct one and write them against the cartoon images.

7
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Bugs Bunny – Tex Avery	 Chhota Bheem – Rajiv Chilaka

Eric Cartman – T. Parker & M.	 Stone Snoopy – Charles M. Schulz

Donald Duck – Walt Disney	 Mickey Mouse – Walt Disney

Goofy – Art Babbit	 Tweety – F. Freleng

Chacha Choudhary – Pran Kumar Sharma

Tom and Jerry – W. Hanna and J. Barbera

WordBank

1)

___________________________

2)

_____________________________

3)

____________________________

4)

____________________________
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5)

___________________________

6)

_____________________________

7)

____________________________

8)

____________________________

9)

____________________________

10)

____________________________
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Melody Makers
Identify these singers from the descriptions given below.

1) 	�This famous Indian singer has won Bharat Ratna,Padma
Bhushan, Padma Vibhushan, National Awards and many
others. She is fondly termed as ‘Didi’ and also the ‘Nightingale
of India’.

__________________________________

2) 	�This female singer started her career with a famous singing
competition on National T.V. and now is one of the most famous
Bollywood singers.

__________________________________

3) 	�This American singer is both a singer and song writer. She is known
for singing narrative songs of her personal experiences and is the
youngest artist to win Album of the Year at the Grammy Awards.

__________________________________

4) 	�She is an American singer, song writer and actress. She has
pursued a career in the gospel music but later shifted towards
secular music. She has been in Guinness Book of World records
4 times.

__________________________________

5) 	�She is famously known as the ‘Queen of pop’. She writes and
produces most of her songs. She holds the title of ‘Best-selling’
female recording artist of all time’ in Guinness Book of Records.

__________________________________

6) 	�This Canadian singer is known for her wide range in singing
from rock to gospel to classical. She sang the famous song
‘My heart will go on’ from the Oscar winning movie Titanic.

__________________________________
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7) 	�This American singer holds the record of ‘Most awarded
female acts’ in Guinness book of World Records. Her debut
album ‘Whitney Houston’ became the best-selling debut
album of a  woman in history.

__________________________________

8) 	�She won the Miss World pageant in the year 2000. She has
established herself as Bollywood actress. She has shown her
versatility in singing and has released her singles ‘In my city’,
‘Exotic’ worldwide.

__________________________________

9) �One of the young promising newcomers of Hindi film industry,
she has also been appreciated for her singing skills. She sang
‘Sooha Sahaa’ from the movie ‘Highway’ and the unplugged
version of ‘Samjhawan’ song.

__________________________________

Lata Mangeshkar was the first Indian to perform at the Royal Albert Hall in 
London in the year 1974.

Do You Know?
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Founders and Organizations
Match the names of some of the famous companies given in 
column A with their founders given in column B.

Column A Column B

1) IBM [    ] a) Bill Gates

2) Microsoft [    ] b) Jerry Yang and David Filo

3) TATA Group [    ] c) Bill Bowerman and Philip Knight

4) Walmart [    ] d) Richard and Maurice

5) Yahoo
[    ]

e)
Robert Wood, James Wood,

Edward Mead
6) Nike [    ] f) Bill Hewlett and David Packard

7) Mc. Donald’s [    ] g) Jamnalal Bajaj

8) Johnson n Johnson [    ] h) Sam Walton

9) Bajaj [    ] i) Jamsetji Tata

10) HP [    ] j) Thomas J. Watson

11) Apple Inc. [    ] k) Mahashay Dharampal

12) MDH [    ] l) Steve Jobs

MIXED BAG8
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Knowing Interesting Facts
Identify the following machines from their descriptions. The names are given in the 
box below.

Microscope	 Lactometer	 Altimeter	 Seismograph

Barometer	 Sphygmomanometer	 Galvanometer

WordBank

1) This machine is used to measure blood pressure.

Ans.	 _______________________________________

2) 		�This machine is used to measure the motions of
the ground like the seismic waves generated by
earthquakes, volcanic eruptions etc.

Ans.	 _______________________________________

3) This instrument is used to study the cells of an organism.

Ans.	 _______________________________________

4) This instrument is used to measure altitude.

Ans.	 _______________________________________
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5) 	�This instrument is used to measure pressure atmospheric
and is helpful in forecasting weather.

Ans.	 _______________________________________

6) 		�This instrument is used to measure the density of the milk
i.e. the amount of cream contained in milk.

Ans.	 _______________________________________

7) This instrument is used to detect electric current.

Ans.	 _______________________________________

Multiple Choice Questions

1) �Doughnut is a very famous dessert. In which of these countries did
it first originate? [   ]

(A) United States of America	 (B) United Kingdom

(C) Germany	 (D) Italy

2) �Raja Ravi Verma is one of the famous painters of India. Which of
these statements are correct about him? [   ]

(A) �He was fond of depicting scenes from Ramayana and 
Mahabharata

(B) He combined both the Indian and European style of painting
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(C) He was from Travancore (Kerala)

(D) All A, B, C

3) Who painted the famous painting ‘The Last Supper’? [   ]

(A) M F Hussain	 (B) Leonardo Da Vinci

(C) Picasso	 (D) Michelangelo

4) What does a dragon symbolize in Chinese culture? [   ]

(A) Bad luck	 (B) Thunderstorm

(C) Power and Good luck	 (D) War

5) Who is the author of the epic Mahabharata? [   ]

(A) Ved Vyasa	 (B) Valmiki [ ]

(C) Kautilya	 (D) Chanakya

6) Where is National School of Drama located? [   ]

(A) Pune	 (B) New Delhi 

(C) Mumbai	 (D) Chennai

7) What is the gift given on the day of Eid called? [   ]

(A) Gift	 (B) Present 

(C) Alm	 (D) Eidi

8) �Which one of these countries uses the word ‘guten tag’ to greet
others? [ ]

(A) France	 (B) Italy

(C) Germany	 (D) Australia
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9) Which one of these countries uses the word ‘bonjour’ to greet others?
[    ]

(A) France	 (B) Italy

(C) Germany	 (D) Australia

Italians use ‘Salve/Ciao’ to greet each other

Do You Know?

Over 10 billion doughnuts are made in the U.S. every year. During World 
War I, the Salvation Army workers used to bring doughnuts and coffee to 
the soldiers in the trenches of France to cheer them up and remind them  
of home.

Fun Fact
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Travelers’ Books
Match the names of the travelers given in Column A with the names of the

books written by them given in Column B.

Column A Column B

1) Megasthenes a) Ain – i- Akbari

2) Fa- Hein b) Rehla

3) Abu’l Fazl c) IL Milione

4) Ibn Battuta d) Indica

5) Al- Beruni e) Travels in the mughal empire

6) Francois Bernier f) A record of Buddhist Kingdoms

7) Marco Polo g) Tahqiq-I- Hind

WORLD HISTORY9
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All About Greek and Classic Mythology
Who Am I?

1) I am the ruler of the Sky and ruler of the Olympian Gods.

Ans.	 _________________________________________________

2) I am the God of the sea, earthquakes and horses.

Ans.	 _________________________________________________

3) I am the goddess of love and beauty.

Ans.	 _________________________________________________

4) I am the goddess of wisdom.

Ans.	 _________________________________________________

5) I am known as the god of War.

Ans. 	 _________________________________________________

6) I am the Goddess of Earth.

Ans.	 _________________________________________________

Cupid in classical mythology is known as God of Love and Affection. He is 
the son of the love goddess Venus and war god Mars. His Greek counterpart 
is known as Eros. It is believed that people fall in love when they are hit by 
golden arrows of Cupid.

Do You Know?
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Statues and Symbols
Identify the names of these famous statues from the given descriptions.

Christ the Redeemer The Thinker	 The Great Sphinx of Giza 
The Little Mermaid	 Statue of Liberty	 Moai David Statue

WordBank

1) 	�I am called the masterpiece of the Human Spirit, I was given as
a gift to the people of America by France.

Ans.	 ____________________________________________

2) 	�I am the largest Art Deco statue all over the world and am
also the fifth largest statue of Jesus. You will find me in Rio De
Janeiro, Brazil.

Ans.	 ____________________________________________

3) �I am made completely of limestone having the body of
lion with a human head. It is believed that the ancient
Egyptians built me around 2558 BC.

Ans.	 ____________________________________________

4) 	�Based on the fairy tale of the same name by Danish author
Hans Christian Andersen, the small and unimposing statue is a
Copenhagen icon It has been a major tourist attraction since 1913.

Ans.	 ____________________________________________

5) 	�I am a bronze statue that is usually used to represent philosophy,
made by the great artist Auguste Rodin.

Ans.	 ____________________________________________
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6) 	�These are several monolithic figures of humans carved out of
rocks by the Rapa Nui people of Easter Island. These statues
are typical in the sense that they have oversized heads,
about three – eighths of the whole statue.

Ans.	 ___________________________________________

7) 	�This statue is considered a master piece from the age of
Renaissance. It was created by famous Italian artist, Michelangelo,
between1501-1504. The statue is a representation of the biblical
hero, David.

Ans.	 ____________________________________________
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POLITICS

Government Types
Match the types of government to their respective definitions.

A B

Monarchy

A system of government in which all the 
people of a state are involved in making 
decisions about its affairs, typically by voting 
to elect representatives to a parliament or 
similar assembly.

Democracy

A form of government where a country is 
ruled by one person or political entity, without 
any checks and balances on its power. They 
capture power to benefit themselves, their 
families and their close political allies.

Dictatorship

A form of government in which sovereignty 
is actually or nominally embodied in one or 
several individual(s) reigning until death or 
abdication.

10
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Books of Politicians
Complete the titles for the books written by famous Indian politicians. You can use 
the Word Bank to find the names of the books.

Wings of Fire	 Discovery of India	 My experiments with Truth

My Presidential	 Years Songs of India	 My Country My Life

Poverty and Un-British rule in India	 Jobs for Millions

India Wins Freedom	 My Truth

WordBank

1) _______________________________ of India

Author: Jawaharlal Nehru

2) My_______________________________ Truth

Author: Mahatma Gandhi

3) My Country _______________________________

Author: L. K. Advani

4) Jobs for_______________________________

Author: V V Giri
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5) _______________________________ Fire

Author: A. P. J. Abdul Kalam

6) _______________________________ Years

Author: R. Ventakaraman

7) _______________________________ rule in India

Author: Dadabhai Naoroji

8) ___________________________ of India

Author: Sarojini Naidu

9) My ___________________________

Author: Indira Gandhi

10) India Wins ___________________________

Author: Maulana Abul Kalam Azad
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World Leaders
Read the description given below and identify the person being described.

Mussolini Adolf Hitler Vladimir Lenin Martin Luther King Jr.

Mao Zedong

1) 	�He was the head of the Italian government from 1922 to 1943. He was the
founder of fascism. As a dictator he held absolute power and severely
mistreated his citizens and his country. He led Italy into three straight wars,
the last of which led to his overthrow by his own people.

Ans. _________________________________________________________________________

2) 	�He was a German dictator. He was the leader of the extreme nationalist
party and served as the Chancellor- President of Germany from 1933 to
1945. He was one of the most powerful leaders of the 20th Century. His
leadership led to the death of nearly six million Jews.

Ans. _________________________________________________________________________
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3) 	�He was Russian and an influential figure in world history. As the founder
of the Bolshevik political party, he was a successful revolutionary leader
who presided over Russia’s transformation from a country ruled by czars
(emperors) to the Union of Soviet Socialist Republics (U.S.S.R.), the name of
the communist Russian state from 1922 to 1991.

Ans. _________________________________________________________________________

4) He was an African- American leader. He originated the use of nonviolence
within the civil rights movement. He has received the Nobel Peace Prize.

Ans. _________________________________________________________________________

5) 	�He was a Chinese statesman and a revolutionary. More than anyone else,
he helped to reshape the social and political structures of his ancient and
heavily populated country.

Ans. _________________________________________________________________________

Adolf Hitler was a vegetarian and so he created laws against animal cruelty. 
He also led the first public anti-smoking campaign.

Fun Fact

The first speaker of Indian Lok Sabha was Ganesh Vasudev Mavalankar.

Do You Know?
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About Polity

RBI Governor

• The Governor of the Reserve Bank of India is the chief executive of India’s
central bank and the ex-officio chairperson of its central board of Directors.

• The Indian currency notes bear the Governor’s signature.

• The RBI was established by the British in 1935.

• The First Indian Governor for the RBI was C. D. Deshmukh.

• Manmohan Singh was the thirteenth Governor of the RBI.

1) Who is the current RBI governor? Also, find a picture of him/her.

Ans. _________________________________________________________________________

2) Were there any women RBI governors? If yes, name her/them.

Ans. _________________________________________________________________________

The Speaker

• The Speaker is the presiding officer of the Lok Sabha.

• He/she conducts the business of the House.

• The Speaker is elected in the very first meeting of the Lok Sabha following
the general elections.

• He/she holds office for a term of five years.

• By convention, he/she is a member of the ruling party or alliance.

• He/she cannot vote or talk on behalf of the ruling party.

1) Who is the current Speaker of the parliament?

Ans. _________________________________________________________________________
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2) Name women speakers of the parliament till date.

Ans. _________________________________________________________________________

Chief Election Commissioner

• He/she heads the Election Commission of India. The body ensures that free
and fair elections are being conducted.

• He/she is a member of the Indian Civil Services and mostly from the Indian
Administrative Services.

• He/she is appointed by the President.

Name the new Chief Election Commissioner of India.

Ans. _________________________________________________________________________
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GLOBE TRAVELERS

It’s Time for Germany, Turkey, Russia, Brazil, Italy

Guess the country name from the given hints.

• This country lies in South America with Brasilia as its capital.

• This is the 5th largest country in terms of area and population.

• The official language of the country is Portuguese and the
currency used is Real.

• Other important cities of this country are Sao Paulo, Rio de
Janeiro, Salvador.

• The	 national	 dish	 of	 this	 country	 is	 Feijoada.	 The
Carnival is	 the	 most	 famous	 festival	 celebrated	 in	 most
parts	 of	 the country.	 Samba	 is	 among	 the	 most
famous	 music	 genre and	the	Bahiana dress	is	one	of	the
traditional	dresses	of	the women.

• Pele, one of the most renowned football players of the world
is born in this country. He has been a 3 times World Cup
champion in football.

• It is the largest producer of coffee in the world

Ans. __________________________________

11
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• The capital of this country is Rome and some of the important
cities include Milan, Naples, Turin etc.

• The official language of this place is Italian and the currency
used is Euro.

• It is a country with rich heritage of literature, art and culture. It
has 51 UNESCO identified heritage sites such as Leaning tower
of Pisa, Castel del Monte, Royal palace at Caserta etc.

• This country is known for elaborate styles of clothing and some
of the brands like Armani, Gucci, Brioni are considered as the
top brands in the world.

• Some of the popular Italian dishes include Pizza, Pasta, Espresso
and Gelato.

• Epiphany and Befana is one of the most celebrated festivals of
Italy with much pomp and show.

• Christopher Columbus, a very well-known explorer was the first
European to discover North America during one of his voyages.

• One of the oldest and influential civilizations of the world rose in the city of Rome.

Ans. _______________________________________

• This country is located in the center of Europe and shares borders
with nine other countries: Austria, Belgium, the Czech Republic,
Denmark, France, Luxembourg, the Netherlands, Poland, and
Switzerland

• The capital of this country is Berlin, it is also the largest city and
has the world’s largest railway station.

• Other major cities include Munich, Hamburg, Cologne, Stuttgart
and Frankfurt.

• This country is the fifth largest country in Europe and second most
populous after Russia, with more than 81 million people.
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• This country is sometimes known as ‘the land of poets and
thinkers’ because, some of the world’s most famous scientists
like Albert Einstein are from this country.

• It was the first country in the world to adopt Daylight saving
time.

• The official language of the country is German, with over 95% of the
population speaking German as their first language.

• World’s first airline was founded in this place.

Ans. _______________________________________

• It is the largest country in the world. Because of its huge size this
place has a very diverse environment.

• This country is located in northeastern Europe and northern Asia.

• The capital of this country is Moscow and the currency used here
is Ruble.

• Other major cities in this country include Saint Petersburg,
Yekaterinburg and Novosibirsk.

• This place has many lakes. Lake Baikal in Siberia is the largest
freshwater lake in the world.

• The country is home to the largest McDonald’s restaurant in
the world.

• One	of	 the	most	well-known	 traditional	 foods	 that	may	 seem
strange	to	an

 
outsider	is	borshch,	also	spelled	borscht.	This	is	a

beet	 soup	 that	 is	 full	of	vegetables
 
and	meat	and	 is	 typically

served	with	a	dollop	of	sour	cream,	a	staple	of	many dishes.
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• Ballet is a popular notable art form coming out of this place.

Ans. _______________________________________

• A very interesting fact about this country is that a part of it lies
in Asia, and a part of it in Europe

• This place is surrounded on three sides by the Black Sea, the
Mediterranean Sea, and the Aegean Sea.

• Istanbul is the largest city in this country and is the third most
populous urban area in Europe. But it is not the capital,
Ankara is in fact the capital of this country.

• The currency used in the country is called the Turkish Lira.

• Many famous ethnic foods come from this place such as
manti, kebab, Lokum (Turkish delight), baklava, kadayif and
more.

• One more interesting fact is that Santa Claus originated in this country. He was
born in the town in Patara and was known as St. Nicholas during his lifetime.

• It is a popular tourist destination and home to over ten World Heritage Sites.

Ans. _______________________________________
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